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Safety

The caution and danger statements that this document contains can be referenced
in the multilingual IBM Safety Information document that is provided with your IBM
TotalStorage FAStT100 Storage Server. Each caution and danger statement is
numbered for easy reference to the corresponding statements in the translated
document.

» Danger: These statements indicate situations that can be potentially lethal or
extremely hazardous to you. A danger statement is placed just before the
description of a potentially lethal or extremely hazardous procedure, step, or
situation.

« Caution: These statements indicate situations that can be potentially hazardous
to you. A caution statement is placed just before the description of a potentially
hazardous procedure step or situation.

» Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage could occur.

Before installing this product, read the following danger and caution notices.
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Statement 1:

A A

DANGER

Electrical current from power, telephone, and communication cables is
hazardous.

To avoid a shock hazard:

* Do not connect or disconnect any cables or perform installation,
maintenance, or reconfiguration of this product during an electrical
storm.

» Connect all power cords to a properly wired and grounded electrical
outlet.

« Connect to properly wired outlets any equipment that will be attached to
this product.

* When possible, use one hand only to connect or disconnect signal
cables.

* Never turn on any equipment when there is evidence of fire, water, or
structural damage.

» Disconnect the attached power cords, telecommunications systems,
networks, and modems before you open the device covers, unless
instructed otherwise in the installation and configuration procedures.

» Connect and disconnect cables as described in the following table when
installing, moving, or opening covers on this product or attached
devices.

To Connect: To Disconnect:

Turn everything OFF. Turn everything OFF.
First, attach all cables to devices.
Attach signal cables to connectors.
Attach power cords to outlet.

Turn device ON.

First, remove power cords from outlet.
Remove signal cables from connectors.
Remove all cables from devices.
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Statement 3:

A

CAUTION:
When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or
transmitters) are installed, note the following:

* Do not remove the covers. Removing the covers of the laser product could
result in exposure to hazardous laser radiation. There are no serviceable
parts inside the device.

» Use of controls or adjustments or performance of procedures other than
those specified herein might result in hazardous radiation exposure.

A

DANGER

Some laser products contain an embedded Class 3A or Class 3B laser
diode. Note the following.

Laser radiation when open. Do not stare into the beam, do not view directly
with optical instruments, and avoid direct exposure to the beam.

Class 1 Laser statement

Cless 1 Laser Product
Lager Klasse 1

Lasar Klass 1

Luiesmn 1 _Lasaﬂaha

Apparall A Laser de Classs 1

IEC 825-11993 CENELEC EN 60 825

Safety V
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Statement 4:

A

= 18 kg (39.7 Ib) = 32 kg (70.5 Ib)

= 55 kg (121.2 Ib)

CAUTION:
Use safe practices when lifting.

Statement 5:

A A

CAUTION:

The power control button on the device and the power switch on the power
supply do not turn off the electrical current supplied to the device. The device
also might have more than one power cord. To remove all electrical current
from the device, ensure that all power cords are disconnected from the power

source.

VAN
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Statement 8:

A A

CAUTION:
Never remove the cover on a power supply or any part that has the following
label attached.

& A\

Hazardous voltage, current, and energy levels are present inside any
component that has this label attached. There are no serviceable parts inside
these components. If you suspect a problem with one of these parts, contact
a service technician.

Safety  Vii
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About this document

This document describes procedures for adding either new Fibre Channel hard
drives or new IBM TotalStorage FASLIT drive expansion enclosures containing new
Fibre Channel hard drives to an existing IBM FASIT Storage Server configuration.
This document also describes the procedure for migrating either Fibre Channel hard
drives or IBM TotalStorage FASIT storage expansion enclosures containing Fibre
Channel hard drives from one FAStT storage subsystem to another.

Who should read this document

This document is intended for system administrators who are familiar with the IBM
TotalStorage FASIT storage subsystem components, terminology, and FAStT
Storage Server administrative tasks.

lllustrations

lllustrations contained in this document depict general visual characteristics of the
FASIT Storage Server, storage expansion unit, and fibre channel drive hardware
cited. They are not intended for use as detailed FAStT storage hardware images.

Using this document

Before you proceed to complete any storage addition or migration procedures
detailed in this publication, familiarize yourself with the principles, prerequisite
instructions at[Chapter 2, “Prerequisites to adding capacity and hard drive]
[migration,” on page 9, as well as the following storage addition or migration
procedures applicable to your specific need.

+ [Chapter 3, “Adding one or more new fibre channel hard drives,” on page 15|
[Chapter 4, “Adding expansion units containing new hard drives,” on page 19|
[Chapter 5, “Migrating one or more fibre channel hard drives,” on page 29
[Chapter 6, “Migrating expansion units containing hard drives,” on page 33|

+ [Chapter 7, “Upgrading a storage server in a functioning configuration,” on page|
41

Your familiarity with the principles, preliminary procedures, and detailed steps
described in this document is critical to prevent loss of data availability, and in some
cases, loss of data. If you have questions about the procedures described in this
document, please contact the IBM Help Center in your geography for assistance.

Important:
1. Do not mix SATA and Fibre Channel drives in the same enclosure.

2. Do not mix SATA drive expansion enclosures (EXP100) and Fibre channel drive
enclosures (EXP700 and EXP500) in the same drive loop or FASIT Storage
Server.

How to send your comments

Your feedback is important to help us provide the highest quality of information. If
you have any comments about this document, please either fill out the Readers’
comments form (RCF) at the back of this document and give it to an IBM
representative, or submit it in one of the following ways:

© Copyright IBM Corp. 2004 XV



e E-mail
Submit your comments over the Internet to:

[starpubs @ us.ibm.com|
— Submit your comments over IBMLink™ from the U.S.A. to:

STARPUBS at SUIEVM5
— Submit your comments over IBMLink from Canada to:

STARPUBS at TORIBM
— Submit your comments over IBM Mail Exchange to:

USIB3WD at IBMMAIL
Be sure to include the name and order number of the document and, if
applicable, the specific location of the text that you are commenting on, such as
a page or table number.
* Mail
Complete the Readers’ comments form (RCF) at the back of this document and

return it by mail. If the RCF Business Reply Mailer has been removed, you may
address your comments to:

International Business Machines Corporation
Information Development

Dept. GZW

9000 South Rita Road

Tucson, Arizona 85744-0001

U.S.A.
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Chapter 1. Introduction

Scalability is a primary attribute of the IBM TotalStorage FAStT Storage Server
family. Whenever the need arises, you can expand a FAStT Storage Server from its
minimum to its maximum capacity configuration. To expand FAStT Storage Server
configurations you can purchase additional equipment or migrate equipment from
FASIT Storage Server configurations previously deployed.

The typical FAStT Storage Server drive connects to both Controller A and Controller
B. Taken together, these connections represent a single drive loop or a redundant
drive loop pair. You must connect drive loops in pairs to enable redundant drive
loop configurations (two data paths per drive enclosure).

provides a list of the maximum allowable number of drives and drive loop
pairs for each FAStT Storage Server by machine type and model number. It also
specifies storage expansion enclosure license requirements.

Table 1. Maximum allowable drives and drive loop pairs for FASIT storage servers

License
Maximum requirement to
Maximum number of |add storage
Machine | Model number of |drive loop |expansion
Product name type number |drives pairs units
IBM TotalStorage 3542 1RU 38 1 None
FAStT200 Fibre 1RX
Channel Storage
Server
IBM TotalStorage 2RU 66 1 None
FAStT200 High 2RX
Availability (HA)
Fibre Channel
Storage Server
IBM TotalStorage 3552 1RU 224 2 None
FAStT500 Fibre 1RX
Channel Storage
Server
IBM TotalStorage 1742 1RU 224 2 None
FAStT700 Fibre 1RX
Channel Storage
Server
IBM TotalStorage 1742 90X 224 2 None
FAStT900 Fibre 90U
Channel Storage
Server

© Copyright IBM Corp. 2004 1



Table 1. Maximum allowable drives and drive loop pairs for FAStT storage
servers (continued)

License
Maximum requirement to
Maximum |number of |add storage

Machine | Model number of |drive loop |expansion
Product name type number |drives pairs units
IBM TotalStorage 1722 60X 56 1 Purchase
FAStT600 Fibre 60U storage
Channel Storage expansion unit
Server entitlements in

increments up to
three storage
expansion units
per FAStT600
Storage Server.

IBM TotalStorage 112 1 None. The
FAStT600 Turbo FAStT600 Turbo
Fibre Channel option includes
Storage Server a seven storage
expansion unit
entitlement.
IBM TotalStorage 6LU 14 0 None. The
FAStT600 Single 6LX FAStT600
Controller Fibre Single Controller
Channel Storage Storage Server
Server does not
support storage
expansion
enclosure
attachment.
Notes:

1. The maximum number of drives supported by the FAStT200 HA Storage Server
(models 2RU and 2RX) assumes attachment to 4 EXP700 storage expansion
enclosures containing 56 fibre channel drives.

2. The maximum number of drives supported by the FAStT500, FAStT700, and
FAStTO00 storage servers assumes their attachment to 16 EXP700 storage
expansion enclosures.

You can mix FAStT TotalStorage EXP500 (which operates only at 1 Gbps) and
FASLT TotalStorage EXP700 (which operates at either 1 Gbps or 2 Gbps) storage
expansion enclosures in the same redundant drive loop pair in all FAStT Storage
Server configurations with one exception. FAStT600 Storage Server configurations
do not accommodate this mix. The FAStT600 Storage Server (models 60X and
60U) supports only FAStT EXP700 storage expansion enclosures.

Although the EXP700 storage expansion enclosure is capable of operating at 2
Gbps, you must set the fibre channel speed of drive loops in a mixed storage
expansion enclosure environment to the lowest fibre channel speed supported by all
hardware in the loop, which is 1 Gbps. If one of the drive loops in a FAStT storage
configuration is set to 1 Gbps, you must set all of the drives loops to 1 Gbps. This
speed restriction applies to all four drive loops in either the FAStT700 or FAStT900
storage subsystem configuration, even where some of the drive loops consist only
of EXP700 storage expansion enclosures that might otherwise operate at 2 Gbps.
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Important: Do not change the speed of a drive loop while the FASIT Storage
Server is powered on. Such a speed change will cause unpredictable results. To
change the speed of a drive loop:

1.

ok 0N

Shutdown the FASLT Storage Server.

Shutdown the FASLT storage expansion enclosures.
Change the fibre channel speed settings.

Power on the FASLT storage expansion enclosures.
Power on the FASLT Storage Server.

Note: For additional information on turning a storage server on and off, see the

appropriate FAStIT Storage Server installation and user’s guide. For more
information on these guides, see the following Web site:

www-1.ibm.com/servers/storage/support/fastt/index.html|

For hardware compatibility, ensure that the environmental service module (ESM)
firmware for each storage expansion enclosure and the storage server controller
firmware are either at or above the levels that are recommended in[Table 6 on page]

[10] and [Table 7 on page 11}

[Figure 1 on page 4]illustrates cabling of FAStT TotalStorage EXP500 and EXP700

storage expansion enclosures in a mixed configuration.

Chapter 1. Introduction
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Figure 1. FAStT EXP500 and EXP700 cabling in a mixed configuration

There are maximum limits to the number of fibre channel hard drives that you can
configure in redundant drive loop pairs. [Table 2 on page 5|lists the numbers of
EXP500 and EXP700 storage expansion enclosures that you can combine for use
in a single redundant drive loop pair. [Table 2 on page 5/ assumes that a FAStT
Storage Server is generally capable of addressing the maximum of 112 fibre
channel hard drives for each redundant drive loop pair.

Important: IBM supports only those EXP500 and EXP700 Storage Expansion Unit
combinations listed in[Table 2 on page 5|
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Table 2. Supported EXP500 and EXP700 combinations per maximum redundant drive loop
pair drives

Total number of

Total number of EXP700 Maximum number of | Maximum number
EXP500 enclosures enclosures per storage expansion of drives per
per redundant drive |redundant drive units per redundant |redundant drive
loop pair loop pair drive loop pair loop pair

1 0 11 110

10 0 10 100

9 1 10 104

8 2 10 108

7 3 10 112

6 3 9 102

5 4 9 106

4 5 9 110

3 6 9 114

2 6 8 104

1 7 8 108

0 8 8 112

Note: The combination of three EXP500 and six EXP700 storage expansion
enclosures has the maximum number of 114 drives per redundant drive loop
pair. You can have this maximum number of hard drives per drive loop pair
only in this mixed EXP500 and EXP700 configuration.

Enclosure IDs

Each drive enclosure in a FASTT storage subsystem drive loop must have a unique
drive enclosure ID. FASLT controllers use a combination of the enclosure ID and the
number of the physical slot that a fibre channel hard drive occupies to create a
unique fibre channel loop address or arbitrated loop physical address (AL_PA) for
each drive in a fibre channel drive loop. The enclosure ID consists of two digits, a
tens (x10) digit and and a ones (x1) digit. The possible values for the tens and the
ones digits are 0-9 for EXP500 drive enclosures, and 0-7 for EXP700 drive
enclosures.

Give each drive expansion enclosure in a redundant drive loop a unique ones digit
ID. This setting will enforce hard AL_PAs (unchangeable between fibre channel
Loop Initializations [LIPs]) for the drives and facilitate drive loop problem
troubleshooting in the event of an error. If the ones digits are not unique, two or
more devices will have the same hard AL_PA. In such a case, the controller will use
soft AL_PAs for the devices that have identical hard AL_PAs.

The problem with soft addressing is that addresses may change between LIPs. This
possibility increases the difficulty of troubleshooting drive loop problems, since one
cannot easily ascertain whether the same device with a different address or a
different device may be causing a problem. Since the FAStT storage server
supports more enclosures than available values of the enclosure ID ones digit,
[Table 3 on page 6}[Table 4 on page 6, and[Table 5 on page 7| suggest enclosure 1D
settings for various drive expansion enclosure families to minimize soft addressing
in a drive loop.
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Table 3. EXP500 Storage Expansion Enclosure ID settings

Enclosure ID setting for | Enclosure ID setting for
Storage expansion enclosure in the first enclosure in the second
enclosure redundant drive loop redundant drive loop
1st unit 00 x0
(storage expansion enclosure, (where x is 2-7)
FAStT600, or FAStT200
Storage Server)
2nd unit 01 x1
(EXP500) (where x is 2-7)
3rd unit 02 X2
(EXP500) (where x is 2-7)
4th unit 03 x3
(EXP500) (where x is 2-7)
5th unit 04 x4
(EXP500) (where x is 2-7)
6th unit 05 x5
(EXP500) (where x is 2-7)
7th unit 06 X6
(EXP500) (where x is 2-7)
8th unit 07 X7
(EXP500) (where x is 2-7)
9th unit 08 x8
(EXP500) (where x is 2-7)
10th unit 09 x9
(EXP500) (where x is 2-7)
11th unit 10 x0
(EXP500) (where x is 3-7)

Note: Drives in the 11th enclosures of of each drive loop in will have soft
AL_PAs.

suggests enclosure ID settings that minimize soft addressing for the
EXP700 Storage Expansion Enclosure in a drive loop.

Table 4. EXP700 Storage Expansion Enclosure ID settings

Enclosure ID setting for | Enclosure ID setting for

Storage expansion enclosure in the first enclosure in the second
enclosure redundant drive loop redundant drive loop
1st unit 00 x0

(storage expansion enclosure, (where x is 1-7)

FAStT600, or FAStT200
Storage Server)

2nd unit 01 x1
(EXP700) (where x is 1-7)
3rd unit 02 X2
(EXP700) (where x is 1-7)
4th unit 03 x3
(EXP700) (where x is 1-7)
5th unit 04 x4
(EXP700) (where x is 1-7)
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Table 4. EXP700 Storage Expansion Enclosure ID settings (continued)

Storage expansion

Enclosure ID setting for
enclosure in the first

Enclosure ID setting for
enclosure in the second

enclosure redundant drive loop redundant drive loop
6th unit 05 x5

(EXP700) (where x is 1-7)

7th unit 06 X6

(EXP700) (where x is 1-7)

8th unit 07 X7

(EXP700) (where x is 1-7)

Note: All drives in drive loops described in [Table 4 on page 6|will be assigned hard

AL_PAs.

suggests enclosure ID settings that minimize soft addressing for the

EXP500 and EXP700 Storage Expansion Enclosure when intermixed in a redundant

drive loop.

Table 5. Intermixed EXP500 and EXP700 Storage Expansion Enclosure ID settings

Storage expansion
enclosure

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop

1st unit

(storage expansion enclosure,
FAStT600, or FAStT200
Storage Server)

00

x0
(where x is 2-7)

2nd unit 01 x1
(EXP500 or EXP700) (where x is 2-7)
3rd unit 02 X2
(EXP500 or EXP700) (where x is 2-7)
4th unit 03 x3
(EXP500 or EXP700) (where x is 2-7)
5th unit 04 x4
(EXP500 or EXP700) (where x is 2-7)
6th unit 05 x5
(EXP500 or EXP700) (where x is 2-7)
7th unit 06 x6
(EXP500 or EXP700) (where x is 2-7)
8th unit 07 X7
(EXP500 or EXP700) (where x is 2-7)
9th unit 10 x0
(EXP500 or EXP700) (where x is 2-7)
10th unit 11 x1

(EXP500 or EXP700)

(where x is 2-7)

Note: The drives in the 9th and 10th enclosures in each drive loop described in

will have soft AL_PAs.
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FAStT Storage Manager installation and support guides

This publication frequently cites IBM TotalStorage FAStT Storage Manager
installation and support guides supporting various versions and operating system
environments. There are currently two, namely:

» IBM TotalStorage FAStT Storage Manager Installation and Support Guide for AlX,
HP-UX, and Solaris

* IBM TotalStorage FASIT Storage Manager Installation and Support Guide for
Intel-based Operating System Environments

Visit the following Web site to access documentation related to your particular
operating system and FAStT Storage Manager version.

www-1.ibm.com/servers/storage/support/fastt/index.html|

See [‘Additional FAStT documentation,” on page 51|for more information.

8  Adding and Migrating Drives and Expansion Enclosures to FAStT Storage Servers


http://www-1.ibm.com/servers/storage/support/fastt/index.html

Chapter 2. Prerequisites to adding capacity and hard drive
migration

Perform the preliminary steps detailed in this chapter before you add storage
capacity or migrate hard drives. After you meet these prerequisite requirements,
proceed to any of the following sections to address your particular storage hardware
addition or migration requirements:

« [Chapter 3, “Adding one or more new fibre channel hard drives,” on page 15|
[Chapter 4, “Adding expansion units containing new hard drives,” on page 19|
[Chapter 5, “Migrating one or more fibre channel hard drives,” on page 29

* |Chapter 6, “Migrating expansion units containing hard drives,” on pa&SSI

+ |Chapter 7, “Upgrading a storage server in a functioning configuration,” on page|

A1)

Failure to perform the steps listed in this section might result in loss of data
availability, and in some cases, loss of data. Perform the following steps on the
FAStT Storage Server to which you will migrate or add new hard drives:

1. Complete a full backup of all data residing on the FASIT Storage Server.
2. Verify that the backup was successful.

3. Verify that the FASET Storage Server has the latest controller firmware,
non-volitile storage random access memory (NVSRAM), and ESM firmware.

Note: If your FASIT Storage Server has controller firmware version 04.01.02.29
or lower, download and install controller firmware version 4.01.02.33 or
higher before you download and install controller firmware version
5.30.xx.xx or higher.

4. Verify that the fibre channel drive firmware is at the latest level.

5. Verify that the FAST Storage Server to which you will migrate the hard drives is
in optimal state. If it is not, perform the appropriate steps listed in the Recovery
Guru to bring the storage server into optimal state.

6. Use the Read Link_Status function of the Storage Manager client program and
the FASIT Storage Server management event log (MEL) to verify that the drive
loops are in optimal state.

7. Investigate and resolve any errors that reported in the FAStT Storage Server
MEL.

8. Save and store the storage subsystem profile of the FASIT Storage Server.

Important: Do not store FASIT Storage Server profiles in the same location as the
logical drives defined on your FASIT Storage Server. Should you do so, and a RAID
array failure occurs during subsequent migration, the data will be lost.

If you are migrating drives from another FAStT Storage Server, you must also
perform the preceding steps 1| through |8 on the FASIT Storage Server from which
you intend to migrate hard drives. You must also perform the following steps to
flush server-cached /O to disks.

1. Stop all programs, services or processes in the host servers that access the
logical drives defined in the migrated hard drives.

2. Verify that there are no programs, services, or processes running in the
background that might write data to the logical drives. (For example, Microsoft®
MSCS service periodically writes to the “Quorum” disk.)
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3. Unmount the file systems to flush I/O from the server cache to disk.

Notes:

a. In a Microsoft Windows® environment, it is also necessary for you to remove
the drive letter or the mount points of the mapped LUNs instead of
unmounting the file systems.

b. Consult documentation associated with your particular operating system for
detailed information regarding the Unmount procedure.

After you meet prerequisites described in this section, proceed to any of the
following sections to address your particular drive migration requirements.

* |Chapter 3, “Adding one or more new fibre channel hard drives,” on page 15|

+ [Chapter 4, “Adding expansion units containing new hard drives,” on page 19|

« [Chapter 5, “Migrating one or more fibre channel hard drives,” on page 29
 |Chapter 6, “Migrating expansion units containing hard drives,” on page 33|

« [Chapter 7, “Upgrading a storage server in a functioning configuration,” on pagel

41]

Verifying ESM firmware and NVSRAM file levels

The controller firmware and NVSRAM of the FAStT Storage Server to which you will
migrate hard drives, and the ESM firmware in the FAStT storage expansion
enclosures must be at the levels indicated in to ensure firmware
compatibility between the migrating and original hardware. Additionally, FAStT
Storage Manager version 8.3 or higher client software, in conjunction with the
controller firmware level 5.30.xx.xx or higher, allows you to upgrade the ESM
firmware while the storage server receives I/O from the host server.

Tip: Even though you can upgrade the FAStT Storage Server and ESM firmware
while it processes I/O from the host server, schedule upgrades to occur during time
periods of low 1/O between the FAStT storage servers and host servers.

lists IBM FAStT machine types and model numbers, as well as their current
firmware (AppWare or BootWare) and NVSRAM versions.

Table 6. Compatible controller firmware and NVSRAM version by machine type and model

number
Firmware version
Product Machine | Model |(AppWare /
name/model type number | BootWare) NVSRAM version
IBM TotalStorage 3542 1RU 05.30.16.00 N3542-1RUR830V09
FAStT200 Fibre 1RX
Channel Storage
Server
IBM TotalStorage 2RU 05.30.16.00 N3542-2RUR830V12
FAStT200 HA Fibre 2RX
Channel Storage
Server
IBM TotalStorage 3552 1RU 05.30.16.00 N3552F500R830V05
FAStT500 Fibre 1RX
Channel Storage
Server
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Table 6. Compatible controller firmware and NVSRAM version by machine type and model
number (continued)

Firmware version
Product Machine | Model |(AppWare /
name/model type number | BootWare) NVSRAM version

IBM TotalStorage 1742 1RU 05.30.16.00 N1742R700R830V05
FAStT700 Fibre 1RX
Channel Storage
Server

IBM TotalStorage 1742 90X 05.30.16.00 N1742F900R830V06
FAStT900 Fibre 90U
Channel Storage
Server

IBM TotalStorage 1722 60X 05.34.02.00 N1722F600R834V01
FAStT600 Fibre 60U
Channel Storage
Server

IBM TotalStorage 05.40.11.00 N1722F600R840V05
FAStT600 Turbo
Fibre Channel
Storage Server

IBM TotalStorage 6LU 05.34.02.00 N1722F60LR834V0
FAStT600 Single 6LX
Controller Fibre
Channel Storage
Server

Note: Visit the following Web site either to verify software version levels or to
identify possible interim updates to firmware and NVSRAM file versions
described in[Table 6 on page 10}

www-1.ibm.com/servers/storage/support/fastt/index.html|

Update the FASLT controller firmware and NVSRAM to the levels indicated in
[Table 6 on page 10| (or higher) before you upgrade the ESM firmware on the
storage expansion enclosures to versions indicated in

lists IBM FAStT storage expansion enclosure models by name, machine
type, model number, and current ESM firmware version.

Table 7. Compatible expansion unit ESM firmware version by machine type and model
number

FAStT Storage Expansion Unit Machine Model ESM firmware
product name/model type number version
IBM TotalStorage FAStT EXP500 3560 1RU 9166
1RX
IBM TotalStorage FAStT EXP700 1750 1RU 9325
1RX

Perform the following steps to upgrade ESM firmware for a down-level controller:

1. Upgrade the FAStT Storage Manager software to the latest version. That is
FAStT Storage Manager version 8.4x for firmware versions 05.3x.xx.xx and

Chapter 2. Prerequisites to adding capacity and hard drive migration
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higher. For additional information, see the IBM TotalStorage FAStT Storage
Manager installation and support guide for the appropriate server operating
system environment at:

[www-1.ibm.com/servers/storage/support/fastt/index.html|

Note: To ensure the highest level of software compatibility, update the host
server's multi-path software (Redundant Disk Array Controller [RDAC],
IBMSAN.CDM, or Linux failover adapter driver) to the level that is either
supported by or released with the controller firmware that you intend to
download. See the following Web site for current details on software
compatibility:

[www-1.ibm.com/support/docview.wss?uid=psg1MIGR-50176|
2. Upgrade the controller firmware and NVSRAM.

Note: See the readme file in the FASIT Storage Manager software package
associated with the appropriate host operating system environment for a
support statement about the concurrent controller firmware download
(that is, downloading code to the FAStT Storage Server while it is
processing I/O from the host server).

3. Upgrade the storage expansion enclosure ESM firmware. With FAStT Storage
Manager version 8.3 or higher and controller firmware version 05.3x.xx.xx or
higher, you can update the ESM firmware while the FAStT Storage Server is
processing I/O from the host server.

Important: Even though the FASIT Storage Server supports controller and ESM
firmware upgrade while the FASIT Storage Server processes I/0O from the host
server, schedule controller and ESM firmware upgrades to occur during time
periods of low I/O between the FAStT storage servers and host servers.

Upgrading fibre channel drive firmware levels

Before you begin migration, upgrade the fibre channel drive firmware to the latest
level. Suspend I/O from the hosts during drive firmware upgrade. Do not move or
migrate fibre channel drives from a 1 Gbps fibre channel environment to a 2 Gbps
fibre channel environment unless you have installed the latest firmware documented
to enable their operation in a 2 Gbps fibre channel environment.

Bringing storage subsystems and drive loops into optimal state

Note: For additional information on how to make this determination, see the FASIT
Problem Determination Guide associated with your particular FAStT
hardware model.

After you have updated or verified that a FAStT Storage Server is using the latest
firmware and NVSRAM:

1. Bring the FASIT Storage Server to its optimal state before reconfiguring it with
new hardware.

2. Use the FASLT Storage Manager client program to display the status of the
FASLT Storage Server and to correct any problems that might cause the FAStT
Storage Server to enter its Needs Attention state.

3. Verify that all indicator lights on the storage subsystem are in their optimal
state.
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4. In addition, use the Read_Link_Status function of the FASIT Storage Manager
client program and the FAStT Storage Server MEL to verify that all components
in the drive loop are in their optimal states (that is, there are no drive loop
component errors in the event log and no errors in the Read_Link_Status
window.)

5. If the arrays are in degraded state due to failed drive, correct the problem before
migration.

If necessary, contact the IBM Help Center in your geography for assistance with
event log interpretation.

It is necessary for certain tasks to complete before proceeding to add drives or
enclosures. Before you add drives or enclosures, verify that the storage subsystem
involved is not performing any of the following tasks.

» Dynamic logical drive capacity expansion (dynamic volume expansion [DVE] or
dynamic capacity expansion [DCE])

» Logical drive segment size modification
* Array RAID-level modification

* User-initiated array redundancy checking (menu option Array » Check
Redundancy in the Subsystem Management window)

* Remote mirror logical drive synchronization
+ FlashCopy® or VolumeCopy logical drive creation

* Logical drive reconstruction or copyback. This action is sometimes referred to as
logical drive sparing.

Saving the storage subsystem profile

Use the FASIT Storage Manager client program to save a FAStT Storage Server
profile. Such a profile is necessary to restore a storage subsystem configuration in
the event of a catastrophic failure. Migration from one FAStT Storage Server
configuration to another will require that you save both FAStT Storage Server
configuration profiles involved. For details on this procedure, see one of the
following:

» FASHT Storage Manager client program Client Subsystem Management window
online help

» IBM TotalStorage FAStT Storage Manager installation and support guide
associated with your particular operating system environment located at:

[www-1.ibm.com/servers/storage/support/fastt/index.htmi|

» Saving a module profile report and state capture information to help prevent data
loss located at:

|www-3.ibm.com/pc/support/site.wss/document.do?lndocid:MIGR-4VVPEF|

Important: Do not store FAStT Storage Server profiles in the same location as the
logical drives defined on your FAStT Storage Server. Should you do so, and a RAID
array failure occurs during subsequent migration, the data will be lost.
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Chapter 3. Adding one or more new fibre channel hard drives

While adding a fibre channel hard drive to either a controller or a drive expansion
enclosure, observe these important rules:

* Observe proper electrostatic discharge (ESD) procedures when handling
electronic equipment.

* Never alter the physical configuration of a FASIT Storage Server while it is
powered off unless you are instructed to do so as part of a FAStT configuration
procedure. Specifically, never attach storage components to or remove storage
components from a configured FAStT Storage Server while it is powered off.

* Any fibre channel hard drive, whether new or old, might contain configuration
data. Unless you intend to migrate a drive from another FAStT Storage System
(retaining its configuration data), always use the following procedure to add one
or more fibre channel drives to a functioning FASIT Storage Server configuration.

Neither FAStT EXP700 storage expansion units nor FAStT600 storage servers
support 1 Gbps fibre channel drives. These drives will not spin up when you
insert them into EXP700 or FAStT600 drive slots.

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine
its ID or Model Number. Hard drives with ID or Model Number values that end
with “04FC” or “O3FC” are 1 Gbps fibre channel drives. For example,
“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that
appear on several 1 Gbps fibre channel hard drives.

The following procedure outlines the steps necessary to add one or more new fibre
channel hard drives to empty drive slots in either FAStT200 or FAStT600 controllers
or in EXP500 or EXP700 storage expansion enclosures. If you plan to add a used
drive, be sure that there is no configuration data on the drive that you need to
preserve. Add drives to a FAStT Storage Server only while it is powered on and in
optimal state. See the FASIT Problem Determination Guide associated with your
particular FAStT hardware model or|‘Bringing storage subsystems and drive loops|
linto optimal state” on page 12|for additional information on how to make this
determination.

Activity 1: Disabling the drive migration settings

Before you add fibre channel drives to the subsystem, perform this activity to
remove any configuration data that they may contain.

1. Open the Storage Manager client program’s Enterprise Management window.

2. Right-click on the name of the FASIT storage subsystem to which you intend to
add fibre channel drives and click Execute Script.

3. A script editor window opens. Click File » Load Script.

4. A Load Script file selection window opens. Locate and select the file named
DisableDriveMigration.scr and click OK. The DisableDriveMigration.scr file is
normally located in the SCRIPTS directory of the IBM FAStT Storage Manager
Installation Compact Disc (CD). Use this file to reset the FAStT storage
subsystem setting to ignore configuration data that might reside on newly
discovered hard drives. [Figure 3 on page 18| provides a listing of the
DisableDriveMigration.scr file.

5. Click Tools » Verify and Execute to run the script.

6. When the script completes execution, reset both FAStT controllers to enable the
FASIT drive migration setting.
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If you used the DisableDriveMigration.scr script associated with this document
and described in [Figure 2 on page 17} it is not necessary for you to perform this
step because the last two commands in that script file automatically reset the
controllers.

To reset the controllers, open the Storage Subsystem Management window and
sequentially (one at a time) reset each controller by clicking Advanced » Reset
Controller. Then, follow the instructions in the Reset Controller window when it
opens.

Activity 2: Inserting fibre channel drives

1.
2.

Insert fibre channel drives as pairs (two at a time) into the empty drive slots.

Wait until each drive pair has fully spun up and displayed in the FAStT Storage
Subsystem Management window before inserting the next drive pair.

Activity 3: Re-enabling the drive migration settings

Perform this activity to re-enable the drive migration settings if you performed

{Activity 1: Disabling the drive migration settings” on page 15 to disable FAStT

storage subsystem drive migration settings. If you do not, whenever you might
subsequently, even momentarily remove a drive from the storage subsystem for any
reason, its configuration data will be cleared. When the storage subsystem next
recognizes such a drive, it will display it as unconfigured.

Attention: In order to prevent data loss, set the FAStT Storage Server drive
migration to enable after you complete the fibre channel hard drive addition
process.

1.
2.

Open the Storage Manager client program Enterprise Management window.

Right-click on the name of the FAStT storage subsystem to which you want to
add fibre channel drives and click Execute Script.

A script editor window opens. Click File » Load Script.

A Load Script file selection window opens. Locate, and select the file named
EnableDriveMigration.scr and click OK. The file EnableDriveMigration.scr is
normally located in the SCRIPTS directory of the IBM FASIT Storage Manager
Installation CD. Use this file to reset the FASIT storage subsystem setting in
order to check for configuration data that might reside on newly discovered hard
drives. [Figure 2 on page 17| provides a listing of the EnableDriveMigration.scr
file.

Click Tools » Verify and Execute to run the script.

When the script completes execution, reset both FAStT controllers to enable the
FASIT drive migration setting.

If you use the EnableDriveMigration.scr script associated with this document
and described in [Figure 2 on page 17} it is not necessary for you to perform this
step because the last two commands in that script file automatically reset the
controllers.

To reset the controllers, open the Storage Subsystem Management window and
sequentially (one at a time) reset each controller by clicking Advanced » Reset
Controller, and then following the instructions in the Reset Controller window
when it opens.

Result: The newly added drives are ready for you to configure and map to host
servers.
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The next two figures list the EnableDriveMigration.scr and DisableDriveMigration.scr

files.

// Name: Enable Drive Migration

// Date: 05-08-2004
// Revision: 1.3
// Comments:

// This script is intended to work with controllers at Firmware 05.30.xx.xx and

// higher only.

// This script returned the FAStT to it's default operation of importing
// configuration informration from disks.

// This script will reboot both controllers in the FAStT unit. If your

// hosts are configured for multi-path support, this can be done with I/0
// running to the controllers. If your hosts are not configured for

// redundant access you must schedule downtime before running this

// script.

// See the directions at the bottom of this script if you do not have multi
// path software installed and wish to prevent the controller restarts

// Show the current state of Drive Migration

show "Showing the current state of Drive Migration (80=0ff, 82=0n)";
show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Setting Drive Migration to Enable

show "Setting Drive Migration to Enable";

set controller[a] nvsrambyte[0x35] = 0x02,0x00;

set controller[b] nvsrambyte[0x35] = 0x02,0x00;

show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Reset Controllers to make changes active. Note:

// To prevent the controllers from restarting, add '//' to the beginning
// of each of the lines below. This will comment out the restart of the
// controllers. Important: The controllers will have to be restarted for the
// changes in this script to take effect.

show "Resetting controller A";

reset Controller [a];

show "Resetting controller B";

reset Controller [b];

show "Drive Migration is now enabled.";

Figure 2. EnableDriveMigration.scr file listing
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// Name: Disable Drive Migration

//

// Date: 05-08-2004

// Revision: 1.3

// Comments:

// This script is intended to work with controllers at Firmware 05.30.xx.xx and
// higher only.

// This script allows the addition of disk drives while the system is running
// and by clearing the configuration of any drives as unused capacity

// regardless of past configuration of these drives.

//

// Attention: This setting should not be Teft active after the new disks have
// been added to the subsystem. Leaving this setting active could

// cause the configuration for the FAStT to be lost if the FAStT is

// power cycled incorrectly. Please run the EnableDriveMigration.scr

// after all the disks are added.

//

//

// This script will reboot both controllers in the FAStT unit. If your

// hosts are configured for multi-path support, this can be done with I1/0
// running to the controllers. If your hosts are not configured for

// redundant access you much schedule downtime before running this

// script.

//

// Show the current state of Drive Migration

show "Showing the current state of Drive Migration (80=0ff, 82=0n)";

show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Setting Drive Migration to Disable

show "Setting Drive Migration to Disable";

set controller[a] nvsrambyte[0x35] = 0x02,0x02;

set controller[b] nvsrambyte[0x35] = 0x02,0x02;

show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Reset Controllers to make changes active

// To prevent the controllers from restarting, add '//' to the beginning

// of each of the lines below. This will comment out the restart of the

// controllers. Important: The controllers will have to be restarted for
// the changes in this script to take effect.

show "Resetting controller A";

reset Controller [a];

show "Resetting controller B";

reset Controller [b];

//

show "Drive Migration is now disabled. Add the new drives to the subsystem,";
show "then execute the EnableDriveMigrationScript.scr to re-enable drive ";
show "migration.";

Figure 3. DisableDriveMigration.scr file listing
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Chapter 4. Adding expansion units containing new hard

drives

While adding storage expansion enclosures containing new hard drives, observe
these important rules:

Observe proper ESD procedures when handling electronic equipment.

Never alter the physical configuration of a FAStT Storage Server while it is
powered off unless you are instructed to do so as part of FAStT configuration
procedure. Specifically, never attach storage components to or remove storage
components from a configured FAStT Storage Server while it is powered off.

Any fibre channel hard drive, whether new or old, might contain configuration
data. Unless you intend to migrate drives from another FAStT Storage System
(retaining their configuration data), always use the following procedure to add
one or more storage expansion enclosures containing one or more fibre channel
hard drives to a functioning FAStT Storage Server configuration.

Neither FAStT EXP700 storage expansion units nor FAStT600 storage servers
support 1 Gbps fibre channel drives. These drives will not spin up when you insert
them into EXP700 or FAStT600 drive slots.

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine its

ID or Model Number. Hard drives with ID or Model Number values that end with
“04FC” or “03FC” are 1 Gbps fibre channel drives. For example, “ST173404FC”,
“ST318203FC” and “ST136403FC” are model numbers that appear on several 1
Gbps fibre channel hard drives.

The following procedure describes the steps required to add one or more FAStT

storage expansion enclosures containing new drives to a functioning FAStT Storage
Server configuration.

Activity 1: Preliminary activities

Add a new FASIT storage expansion enclosure as follows:

1.

Verify that the FASET Storage Server is both powered on and in optimal state.
See the FAStT Problem Determination Guide associated with your particular
FASIT hardware model or [‘Bringing storage subsystems and drive loops into]
[optimal state” on page 12|for additional information on how to make this
determination. You can perform this process while the FAStT Storage Server is
processing I/O from or to the host server. However, because the drive loops are
interrupted momentarily during the addition process, schedule additions to occur
during time periods of low 1/0O between the FASTIT storage servers and host
servers. Review the readme and the IBM TotalStorage FAStT Storage Manager
installation and support guide associated with the operating system environment
of the host servers that connect to the FASIT Storage Server for any additional
restrictions or required preparation tasks specific to your particular operating
system environment. You will find the IBM TotalStorage FAStT Storage Manager
installation and support guides at:

[www-1.ibm.com/servers/storage/support/fastt/index.html|

2. Unpack and mount any additional storage expansion enclosures in the rack
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Important: Do not fully insert hard drives into the enclosures at this time. Keep
them unlatched and no less than %-inch away from their full insertion points in
the drive slots.

3. Set the enclosure ID of the additional storage expansion enclosures. Each drive
enclosure in the FASIT storage subsystem drive loop must have a unique drive
enclosure ID. In a EXP500 storage expansion enclosure, there is an enclosure
ID switch mounted on each of two ESM canisters. Set each ESM canister’s
enclosure ID switch in the EXP500 drive enclosure to the same unique number
in the drive loop. In a EXP700 storage expansion enclosure, the only enclosure
ID switch is mounted between the power supplies. See the appropriate FASIT
storage expansion unit installation and user’s guide for additional information.
illustrates the location of fibre channel speed switches on the EXP700
and EXP500 storage enclosures.
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Figure 4. EXP700 and EXP500 enclosure ID and fibre channel speed switches

If the FASET Storage Server to which the storage expansion enclosure will
attach is either a FAStT200 or FAStT600 machine type, the enclosure IDs of
additional storage expansion enclosures must differ from the FAStT200 or
FAStT600 storage server enclosure IDs, which are normally set at “0” at the
factory.

4. Verify that the EXP700 Storage Expansion Unit speed switch is set to the
correct drive loop speed.

Note: If the enclosure speed switch was originally set to 1 Gbps, do not
automatically set it to 2 Gbps unless you are sure that each fibre channel
hard drive that it now contains is capable of 2 Gbps operation and that
you have installed the latest firmware enabling their operation in a 2
Gbps fibre channel environment.

5. Insert the small form-factor pluggables (SFPs) or gigabit interface converters
(GBICs) into only those fibre channel ports you intend to use. Do not leave
GBICs or SFPs inserted into fibre channel port slots without connecting them to
other fibre channel ports using fibre channel cables.

Activity 2: Cabling new storage expansion units

To complete addition of FASIT storage expansion enclosures, cable the new
storage expansion enclosures to the end of the functioning storage expansion
enclosure drive loop to which you are migrating them. Add only one enclosure at a
time to a functioning drive loop if you intend to attach multiple storage expansion
enclosures.

The cabling instructions in the steps that follow are based on the cable routing
scheme that is documented in IBM TotalStorage FAStT Storage Manager
installation and support guides. The cabling instructions illustrated in

lbage 22| [Figure 6 on page 23, and [Figure 7 on page 24 describe cabling a FAStT
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EXP700 Storage Expansion Enclosure to the redundant drive loop of a functioning
FAStT600 Storage Server (model 60X or 60U).

The general cabling scheme for FAStT external drive enclosures is described in the
IBM TotalStorage FAStT Fibre Channel Cabling Guide available at:

www-3.ibm.com/pc/support/site.wss/document.do?Indocid=MIGR-4KELS5

1. Extend one of the drive loops (that is, drive loop A) in a FAStT Storage Server
redundant drive loop pair by connecting the OUT port of the last storage
expansion enclosure to the IN port of the new storage expansion enclosure as
shown inFigure 5 on page 22|
Warning: Carefully reconfigure only one drive loop at a time, making sure that
the drive loop that you modify is properly connected and in optimal state before
you attempt to reconfigure another drive loop. Take this precaution to prevent
the arrays from being inadvertently failed by the FAStT Storage Server
controllers. This happens when two or more drives in the arrays cannot be
reached through either drive loop in the redundant drive loop pair.

2. Power on the newly added storage expansion enclosure unit.

3. Wait a few seconds; verify that the port bypass LEDs of all of the ports in drive
loop A, now extended to the new storage expansion enclosure, are not lit. Using
the FASIT Storage Manager Client Subsystem Management window, verify that
the new storage expansion enclosure is added and displayed in the
Logical/Physical view of the window.

Correct any errors before proceeding to step For port bypass:

a. Verify that the SFPs and GBICs or fibre channel cables are in good
condition.

b. Remove and reinsert SFPs, GBICs and fibre channel cables.

Make sure the new drive expansion enclosure fibre channel speed switch is
set to the same speed as the existing drive expansion enclosures and the
FASIT Storage Server fibre channel speed setting.

d. Verify that the ESM is good by physically removing and swapping it with the
other ESM in the same drive expansion enclosure. For enclosure ID conflict,
set the drive expansion enclosure ID switch to values unique from the
current settings in the existing drive expansion enclosures and storage
server.

Call the IBM Help Center in your geography for assistance if the problems
persist.

4. In the other drive loop (that is, drive loop B) in a FAStT Storage Server
redundant drive loop pair, remove the fibre channel connection from the storage
subsystem drive loop port to the OUT port of the last storage expansion
enclosure and connect it to the OUT port of the new drive enclosure as shown in
[Figure 6 on page 23

5. Wait a few seconds; verify that the port bypass LEDs of the two ports in the
fibre channel connection between the storage subsystem drive loop port and the
OUT port of the new drive enclosure are not lit. Using the FASIT Storage
Manager Client Subsystem Management window, verify that the new drive
enclosure does not indicate the drive enclosure Tost redundancy path error.
See the preceding step@ for possible corrective actions, if needed.

6. In drive loop B, cable the new drive enclosure’s IN port to the OUT port of the
last enclosure in the already functioning storage expansion enclosure drive loop
as shown in|Figure 7 on page 24|
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7. Wait a few seconds; verify that the port bypass LEDs of all of the ports in drive
loop B to which you have added a new fibre channel connection are not lit.
Using the FASIT Storage Manager Client Subsystem Management window,
verify that all of the drive enclosures in the FAStT redundant drive loop pair to
which the new enclosure was added does not report the drive enclosure Tost
redundancy path error.
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Figure 5. First connection: Cabling a single drive enclosure to a functioning drive loop
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Figure 6. Second connection: Cabling a single drive enclosure to a functioning drive loop
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Figure 7. Third (final) connection: Cabling a single drive enclosure to a functioning drive loop

Activity 3: Disabling storage subsystem drive migration settings

When you have completed cabling the new storage expansion enclosures, disable
FASIT storage subsystem drive migration settings as follows:

1. Open the Storage Manager Client program Enterprise Management window.

2. Right-click on the name of the FAStT storage subsystem to which you want to
add fibre channel drives, and select Execute Script.

3. A script editor window opens. Click File » Load Script.

4. A Load Script file selection window opens. Locate and select the
DisableDriveMigration.scr file and click OK. The file DisableDriveMigration.scr
file is normally in the SCRIPTS directory of the IBM FAStT Storage Manager
Installation CD. This file is used to reset the FASIT storage subsystem setting,
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in order to treat all newly-discovered hard drives as “new” drives, and to ignore
any configuration information that might exist in the new hard drives.
contains the DisableDriveMigration.scr file listing.

Click Tools » Verify and Execute to run the script.

When the script execution completes, reset both FAStT controllers to make the
disable drive migration settings effective. If you used the
DisableDriveMigration.scr file described in this document in[Figure 3 on page|
, you do not need to perform this step because the last two commands in the
script file automatically reset the controllers. To reset the controllers, open the
Storage Subsystem Management window and alternately (one at a time) reset
each controller by clicking Advanced » Reset Controller and following the
instructions in the Reset Controller window when it opens.

Activity 4: Inserting drives and cabling additional storage expansion

units

Once you have disabled FASLT storage subsystem drive migration settings, insert
drives and connect additional storage expansion enclosures to complete the
installation process as follows:

1.

Insert the appropriate fibre channel drives into empty drive slots in the new
enclosure in pairs (two at a time). Wait until the inserted drive pair fully spins up
and displays in the FAStT Storage Subsystem Management window before
inserting the next drive pair.

To connect additional storage expansion enclosures to the functioning drive loop
pair, perform [Activity 1: Preliminary activities|step [2 on page 19| through step [f]
[on page 20} [Activity 2: Cabling new storage expansion units|step |1 on page 21|
through step |(_3 on page 21|, and step [1| (immediately preceding this step) for
each additional storage expansion enclosure that you intend to add . (See
Figure 8 on page 26,) When you have completed adding enclosures, proceed to
Activity 5: Re-enabling drive migration settings|step1 on page 27|to re-enable
the drive migration settings.
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Figure 8. Cabling a second drive enclosure to a functioning drive loop

Activity 5: Re-enabling drive migration settings

If you performed steps [1 on page 24]through [6 on page 25| of[Activity 3: Disabling]
Istorage subsystem drive migration settings|to disable FAStT storage subsystem
drive migration settings, perform the following steps [1_on page 27 through [6 on]
to re-enable the drive migration settings. If you should ever momentarily
remove a drive from the storage subsystem, the storage subsystem clears its

configuration data when it later recognize it. When this happens, the drive displays
as unconfigured.

Attention: In order to prevent data loss, set the FAStT Storage Server drive

migration setting to enable after you complete the fibre channel hard drive addition
process.
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1. Open the Storage Manager Client program Enterprise Management window.

2. Right-click on the name of the FASLIT storage subsystem to which you want to
add fibre channel drives and click Execute Script.

3. A script editor window opens. Click File » Load Script.

4. A Load Script file selection window opens. Locate and select the
EnableDriveMigration.scr file and click OK. The file EnableDriveMigration.scr file
is normally in the SCRIPTS directory of the IBM FASIT Storage Manager
Installation CD. Use this file to reset the FAStT storage subsystem setting in
order to check for any configuration data that might exist on the newly
discovered hard drives.

5. Click Tools » Verify and Execute to run the script.

6. When the script execution completes, reset both FAStT controllers to make the
setting effective.

If you use the EnableDriveMigration.scr script associated with this document
and described in |Figure 2 on page 17[ it is not necessary for you to perform this
step because the last two commands in that script file automatically reset the
controllers. To reset the controllers, open the Storage Subsystem Management
window and alternately (one at a time) reset each controller by clicking
Advanced » Reset Controller and following the instructions in the Reset
Controller window when it opens.

Result: The newly added drives are now ready for you to configure and map to
host servers.

Note: Listings of the EnableDriveMigration.scr and DisableDriveMigration.scr files
are found in [Figure 2 on page 17|and [Figure 3 on page 18}
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Chapter 5. Migrating one or more fibre channel hard drives

While migrating a fibre channel hard drive to either a controller or a drive expansion
enclosure, observe these important rules:

* Observe proper ESD procedures when handling electronic equipment.

* Never alter the physical configuration of a FAStT Storage Server while it is
powered off unless you are instructed to do so as part of FAStT configuration
procedure. Specifically, never attach storage components to or remove storage
components from a configured FAStT Storage Server while it is powered off.

» Use this procedure to preserve the configuration and user data in one or more
fibre channel hard drives that you will migrate to a functioning FAStT Storage
Server configuration. Do not use this procedure if you are unsure of the quality of
the data on the fibre channel hard drives.

Neither FAStT EXP700 storage expansion units nor FAStT600 storage servers
support 1 Gbps fibre channel drives. These drives will not spin up when you insert
them into EXP700 or FAStT600 drive slots.

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine its
ID and Model Number. Hard drives whose ID/Model Number values end with
“04FC” or “03FC” are 1 Gbps fibre channel drives. For example, “ST173404FC”,
“ST318203FC” and “ST136403FC” are model numbers that appear on several 1
Gbps fibre channel hard drives.

This procedure describes the steps that you must perform to migrate one or more
fibre channel drives from a functioning FAStT Storage Server configuration to
another FASIT Storage Server configuration. Drives described in the following steps
are those that contain configuration data that you want to preserve. Add such drives
to a FASLT Storage Server only while it is powered on and in its optimal state. See
the FASIT Problem Determination Guide associated with your particular FAStT
hardware model or [‘Bringing storage subsystems and drive loops into optimal state’]
Ign page 12| for additional information on how to make this determination.

Tip: Before you attempt to complete the drive migration procedure, review and
perform the steps documented in [Chapter 2, “Prerequisites to adding capacity and|
lhard drive migration,” on page 9

The procedure for migrating hard drives which contain configuration data that you
want to preserve is as follows:

Activity 1: Preliminary activities

Before you remove drives from a functioning FAStT Storage Server, perform the
following steps to ensure that you successfully migrate the drives to the destination
FASIT Storage Server.

1. Perform a backup of the logical drives defined in the hard drives that you plan
to migrate.

2. Stop all programs, services or processes in the host servers that access the
logical drives defined in the migrated hard drives. Make sure that there are not
any running background programs, services or processes that write data to the
logical drives. (For example, the Microsoft MSCS service periodically writes to
the “Quorum” disk.)

3. Unmount the file systems to flush 1/O from the server cache to disks.

© Copyright IBM Corp. 2004 29



10.

11.

12.

13.

Notes:

a. In a Microsoft Windows environment, remove the drive letter or the mount
points of the mapped LUNSs instead of unmounting the file systems.

b. Consult documentation associated with your particular operating system for
detailed information regarding the Unmount procedure.

Verify that the FASIT Storage Server controller and NVSRAM of both the
source and destination systems are at or above levels described in
lpage 14

Verify that the names of the logical drives that are associated with hard drives
on both the source and destination systems are unique. If they are not, make
the necessary changes.

In addition to array configuration information, any storage partitioning
configuration data that may reside on drives you plan to migrate will migrate
with those drives when installed on another FASIT Storage Server. For this
reason, take the following precautions to facilitate the migration process and
prevent problems in storage partitioning configuration data migration.

a. If a FASTT storage partitioning premium feature has been enabled both on
a drive’s original and destination FAStT storage servers, assure that the
defined host ports, hosts, and host group names are unique to each FAStT
storage server involved in the migration.

b. If you must use identical names on both FASIT storage servers, make the
names unique before you perform the drive migration.

If necessary, customize the storage partioning information on the FAStT
storage server to which you have migrated the drives after you complete the
migration.

Delete any flashcopies of the logical drives defined on the drives that you plan
to migrate.

Remove any remote mirror relationships using the logical drives defined on the
drives that you plan to migrate.

Ensure that the arrays and logical drives are in optimal state before starting
the migration process. See the FASIT Problem Determination Guide
associated with your particular FAStT hardware model or[‘Bringing storage]
[subsystems and drive loops into optimal state” on page 12| for additional
information on how to make this determination.

Place the arrays defined in the hard drives that you plan to migrate in offline
state. To do so, right-click on the name of the array in the Storage Subsystem
Management window and click Place » Offline.

If you migrate drive expansion enclosures from a 1 Gbps fibre channel
environment to a 2 Gbps fibre channel environment, verify that the fibre
channel hard drives that you plan to migrate are each capable of 2 Gbps
operation and that you have installed the latest firmware enabling them to work
properly in a 2 Gbps fibre channel environment.

Save the FASIT storage subsystem profile of the functioning FAStT Storage
Server configuration to which the migration will occur in a location other than
that of the logical drives you plan to migrate.

If you migrate the drives to a single controller FAStT Storage Server (for
example, FAStT600 Storage Server Model 6LU or 6LX), change the logical
drive’s preferred owner to Controller A using the FASIT Storage Manager client
program before taking it offline and removing it from the FAStT Storage Server.
To set Controller A as the the logical drive preferred owner, right-click the
logical drive entry in the Subsystem Management window and select Change
» Ownership/Preferred Path » Controller A.
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Activity 2: Removing the migrating fibre channel hard drives

While the functioning FASIT Storage Server is still powered on, remove the hard
drives that you plan to migrate one at a time using the following steps:

1. Press on the inside of the bottom of the tray handle to release the blue latch.

2. Lift the closed latch to its open position. (The latch is at a 90-degree angle to
the front of the drive when open.)

3. Using the handle, slowly pull the drive %-inch out of its drive slot.

4. Wait at least 20 seconds to allow the hard drive to spin down before fully
removing it from the drive slot.

5. Place the hard drive into an ESD bag or container before moving it to the new
FASIT Storage Server.

mig00007

Figure 9. Drive CRU assembly
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Attention: Orient fibre channel drives horizontally and place them in appropriate
ESD bags or containers before relocation. When in transit, use only moving
equipment that prevents shock to the drives. Never stack fibre channel drives.
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Activity 3: Inserting the migrating fibre channel hard drives

1.

While the destination FAStT Storage Server is powered on, insert the migrating
fibre channel drives into the empty drive slots in pairs. Wait until the inserted
drive pair is fully spun up and displayed in the FAStT Storage Subsystem
Management window before inserting the next drive pair.

As the the FASLT Storage Server recognizes the drives, it reads and displays
the array and logical drive information in the Logical/Physical view of the FAStT
Storage Subsystem Management window. The storage subsystem represents
arrays in offline state until it recognizes that you have inserted all of the drives
that comprise an array.

After you migrate all of the drives, manually change the state of the arrays and
logical drives involved from optimal to online state if it has not changed
automatically. To do so, right-click on the array name in the Storage Subsystem
Management window and select Place » Online. If any of the following
conditions persist, contact the IBM Help Center in your geography for
assistance:

e The empty drive slot icon (
inserted the migrating drive.

displayed for the drive slot into which you

* The Failed unconfigured drive icon ( @ ) or the Failed configured drive icon

( ) displayed for the drive slot into which you inserted the migrating drive.
* Array configuration data on the drives you have added is incomplete.
* You cannot bring the array online.

Attention: Do not initialize a drive that you want to keep (by right-clicking its
icon and selecting Initialize from the pull-down menu) if it contains configuration
or user data. Initializing any drives in a defined array causes all hard drives
known to comprise that array to return to the Unconfigured Capacity storage
pool, deleting their array definitions from the FAStT Storage Server
configuration. The user data on such drives is lost.

Result: Once the arrays are online, they are ready to for you to configure and
map to host servers. You might also then recreate flashcopies of the logical
drives.

Use the FASET Storage Manager program to view the storage partitioning
definitions and make any necessary corrections.

The FASLT Storage Server that the fibre channel drives are migrated from will
display the logical drives that are defined in these drives as “missing LUNS”. In
order to remove these “missing LUNS” entries, right-click on each entry and
select Delete from the pull-down menu.
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Chapter 6. Migrating expansion units containing hard drives

While migrating a fibre channel hard drive to either a controller or a drive expansion
enclosure, observe these important rules:

* Observe proper ESD procedures when handling electronic equipment.

* Never alter the physical configuration of a FAStT Storage Server while it is
powered off unless you are instructed to do so as part of FAStT configuration
procedure. Specifically, never attach storage components to or remove storage
components from a configured FAStT Storage Server while it is powered off.

» Use this procedure to preserve the configuration and user data in one or more
fibre channel hard drives that you will migrate to a functioning FAStT Storage
Server configuration. Do not use this procedure if you are unsure of the quality of
the data on the fibre channel hard drives. Import of incorrect configuration data
from fibre channel hard drives could cause a FAStT Storage Server failure.

Use this procedure to migrate one or more FAStT storage expansion enclosures
containing hard drives which themselves contain configuration data from a
functioning FASIT Storage Server configuration to another FASIT Storage Server
configuration.

Attention: Make additions to the FAStT Storage Server only while it is powered on
and in optimal state. See [‘Bringing storage subsystems and drive loops into|
|optima| state” on page 12| for additional information on how to make this
determination. You can complete this process while the FAStT Storage Server is
receiving I/O from the host server. However, because the drive loops are interrupted
momentarily during the addition process, schedule the addition to occur during time
periods of low I/O between the FASIT storage servers and host servers.

Review the readme and the IBM TotalStorage FAStT Storage Manager installation
and support guides associated with the operating system environment of the host
servers that connect to the FAStT Storage Server for information about any
operating system-specific restrictions in addition to those detailed in this document.
You will also find preliminary tasks that you may be required to complete detailed in
that documentation. IBM TotalStorage FAStT Storage Manager installation and
support guides are located at the following Web site:

www-1.ibm.com/servers/storage/support/fastt/index.html|

Tip: Before proceeding with the migration procedure, review and perform the steps
outlined in |[Chapter 2, “Prerequisites to adding capacity and hard drive migration,”|

|9n page 9.

The procedure for migrating a new FAStT storage expansion enclosure is as
follows:

Activity 1: Preliminary activities

Before disconnecting any storage expansion enclosures from a FAStT Storage

Server, to ensure a successful migration of your drives to the FASIT Storage

Server, perform the following steps:

1. Verify that both the functioning source and the destination FAStT Storage
Servers’ controller firmware and NVSRAM are at the levels recommended in
[Table 6 on page 10}
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Verify that the firmware of the ESMs in the storage expansion enclosures that
you plan to migrate are at the levels recommended in|Table 7 on page 11}

Verify that the firmware of the ESMs in the storage expansion enclosures
attached to the FAStT Storage Server to which you will migrate your drives is at
the levels recommended in[Table 7 on page 11|

If you migrate storage expansion enclosures from a 1 Gbps fibre channel
environment to a 2 Gbps fibre channel environment, verify that the fibre channel
hard drives that you plan to migrate are each capable of 2 Gbps operation and
that you have installed the latest firmware enabling them to work properly in a 2
Gbps fibre-channel environment.

Verify that the names of the logical drives that are created using the hard drives
in the migrated storage expansion enclosures are unique in the FASIT Storage
Server to which these storage expansion enclosures will migrate. If they are not
unique, make any necessary changes.

If you migrate the drives to a single controller FASIT Storage Server (for
example, FAStT600 Storage Server Model 6LU or 6LX), change the logical
drive’s preferred owner to Controller A using the FASIT Storage Manager Client
program before taking it offline and removing it from the FAStT Storage Server.
To set Controller A as the the logical drive preferred owner, right-click the logical
drive entry in the Subsystem Management window and select Change -
Ownership/Preferred Path » Controller A.

Activity 2: Deleting partition mappings, remote mirror relationships,

and flashcopies

1.

In addition to array configuration information, any storage partitioning
configuration data that may reside on drives you plan to migrate will migrate
with those drives when installed on another FAStT Storage Server. For this
reason, take the following precautions to facilitate the migration process and
prevent problems in storage partitioning configuration data migration.

a. If a FASHT storage partitioning premium feature has been enabled both on a
drive’s original and destination FAStT storage servers, assure that the
defined host ports, hosts, and host group names are unique to each FAStT
storage server involved in the migration.

b. If you must use identical names on both FASIT storage servers, make the
names unique before you perform the drive migration.

If necessary, customize the storage partioning information on the FAStT storage
server to which you have migrated the drives after you complete the migration.
Delete any flashcopies of logical drives defined in the hard drives that you plan
to migrate.

Remove any remote mirror relationships that involve the logical drives defined
on the drives that you plan to migrate.

Activity 3: Preparing and backing up the drives

1.

2.

If the arrays and logical drives involved are not in optimal state, perform the
steps necessary to bring these arrays and logical drives to their optimal state
before attempting migration. See |“Bringing storage subsystems and drive Ioops|
into optimal state” on page 12 for additional information on how to make this
determination.

If the drive enclosures that you plan to migrate are not in optimal state, perform
the steps necessary to bring them to their optimal state before attempting
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migration. See [“Bringing storage subsystems and drive loops into optimal state’]
|on page 12| for additional information on how to make this determination.

Perform a backup of the logical drives defined in the storage expansion
enclosures that you plan to migrate.

Monitor the FAStT Storage Server event log for any errors in the drive loop or
its components for several days before migrating storage expansion enclosures.

Stop all programs, services or processes in the host servers that access the
logical drives defined in the migrated hard drives. Make sure that there are not
any running background programs, services or processes that write data to the
logical drives. (For example, Microsoft MSCS service periodically writes to the
“Quorum” disk.)

Unmount the file systems to flush 1/O from the server cache to disks.

Notes:

a. In a Microsoft Windows environment, remove the drive letter or the mount
points of the mapped LUNs instead of unmounting the file systems.

b. Consult documentation associated with your particular operating system for
detailed information regarding the Unmount procedure.

Place the arrays defined in the storage expansion enclosures that you plan to
migrate in off1line state. In the Storage Subsystem Management window,
right-click on the name of the array and click Place » Offline.

Save the FASLT storage subsystem profile of the functioning FAStT Storage
Server configuration to which the migration will occur in a location other than
that of the logical drives you plan to migrate.

Activity 4: Shutting down and moving the storage expansion unit

1.

Because removing a storage expansion enclosure from a functioning FAStT
Storage Server will disrupt its drive loops, shutdown the functioning destination
FASIT Storage Server while you remove its storage expansion enclosures for
reconfiguration. If you cannot shutdown the FASIT Storage Server, carefully
reconfigure only one drive loop, making sure that the drive loop that you modify
is connected correctly and in optimal state before you attempt to reconfigure
the other drive loop. For additional information on making this determination,
see [‘Bringing storage subsystems and drive loops into optimal state” on pagel
Take this precaution to prevent the arrays from being inadvertently failed by the
FAStT Storage Server controllers because two or more drives in the arrays
cannot be reached through either drive loop in the redundant drive loop pair.
Perform the following steps to verify that the drive loops are in optimal state:
a. Physically trace the actual fibre channel cable connections making sure that
fibre channel connections are properly modified and that the fibre channel
cable connectors are firmly inserted into the SFPs or GBICs.
b. Verify that the following LEDs are not lit or briefly flashed in the modified
drive loop:

* ESM Fault
* port bypass
e |D conflict

c. Verify that the controller drive loop LED remains lit. If the controller drive
loop LED becomes unlit momentary, there are problems in the drive loop
and the fibre channel Loop Initialization Primitives (LIPs) are generated by
the FASIT Storage Server controller.
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d. In the FASIT Storage Manager Client Subsystem Management window,
verify that there are no loss of ESM path redundancy errors in the storage
expansion enclosures that are not migrated.

Do not modify the second drive loop in the redundant drive loop pair until
you are sure that the first modified drive loop is operating optimally.

2. Power down the storage expansion enclosures and move them to the FAStT
Storage Server to which you plan to migrate them.

Notes:

» A storage expansion enclosure with 14 drives weighs up to 100 Ibs. (45 kg).
If necessary, remove the drives and other storage expansion enclosure
components to reduce the weight of the unit for easier handling. Mark each
drive before removing it in order to return it to the same drive slot when you
reassemble the components at the destination location.

* Move fibre channel drives only in a horizontal position using an appropriate
ESD bag or container and moving equipment that prevents shock to the
drives during transit. Never stack fibre channel drives.

Activity 5: Installing and setting storage expansion unit IDs and

speeds

1. Once the storage expansion enclosures and drives are at the location of FAStT
Storage Server to which they will be migrated, install them into the rack. If the
drives were removed during transit, return them to the slots from which they
were removed, unlatched and no less than %-inch away from from their full
insertion points in the drive slots. If the drives were not removed, unlatch and
pull them out no less than %-inch away from their full insertion points in the drive
slots.

2. See|Figure 4 on page 20| for an illustration of how to set the enclosure ID of the
storage expansion enclosures. Each drive enclosure in the FASLT storage
subsystem drive loop must have a unique drive enclosure ID. In a EXP500
Storage Expansion Unit, there is an enclosure ID switch mounted on each of
two ESM canisters. Set each ESM canister’s enclosure ID switch in the EXP500
drive enclosure to the same unique number in the drive loop. In a EXP700
Storage Expansion Unit, the only enclosure ID switch is mounted between the
power supplies. To access the appropriate FAStT storage expansion unit
installation and user’s guide for additional information, use the following Web
link:.

[www.storage.ibm.com/disk/fastt/index.htmi|

Important: If the FAStT Storage Server to which you will attach migrating hard
drives is either a FAStT200 or FAStT600 (model 60X or 60U) machine type, the
enclosure IDs of additional storage expansion enclosures must differ from the
FAStT200 or FAStT600 storage servers’ enclosure IDs. These IDs are normally
set to “0” at the factory.

3. Verify that you set the enclosure speed switch of the FAStT700 to the correct
drive loop speed.

If the enclosure speed switch was originally set to 1 Gbps, do not automatically
set it to 2 Gbps unless you are sure that each fibre channel hard drive it now
contains is capable of 2 Gbps operation and that you have installed the latest
firmware enabling their operation in a 2 Gbps fibre-channel environment.
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Activity 6: Cabling, powering on, and verifying storage expansion unit

operation

Insert the SFPs or GBICs only into the fibre channel ports that you plan to use.
Do not leave GBICs or SFPs inserted into fibre channel port slots without
connecting them to other fibre channel ports using fibre channel cables.

Cable the new storage expansion enclosures to the end of the functioning
storage expansion enclosure drive loop to which you are migrating them.

Add only one enclosure at a time to a functioning drive loop if you intend to
attach multiple storage expansion enclosures. The cabling instructions are
illustrated in [Figure 5 on page 22|

The general cabling scheme for FAStT external drive enclosures is described in
the IBM TotalStorage Fibre Channel Cabling Guide, which is available at:

[www-3.ibm.com/pc/support/site.wss/document.do?Indocid=MIGR-4KELS5|

Extend one of the drive loops (that is, drive loop A) in a FASIT Storage Server
redundant drive loop pair by connecting the OUT port of the last storage
expansion enclosure to the IN port of the new storage expansion enclosure as
shown in[Figure 5 on page 22

Warning: Carefully reconfigure only one drive loop at a time, making sure that
the drive loop that you modify is properly connected and in optimal state before
you attempt to reconfigure another drive loop. Take this precaution to prevent
the arrays from being inadvertently failed by the FAStT Storage Server
controllers. This happens when two or more drives in the arrays cannot be
reached through either drive loop in the redundant drive loop pair.

Power on the newly added storage expansion enclosure unit.

Wait a few seconds; verify that the port bypass LEDs of all of the ports in drive
loop A, now extended to the new storage expansion enclosure, are not lit. Using
the FASIT Storage Manager Client Subsystem Management window, verify that
the new storage expansion enclosure is added and displayed in the
Logical/Physical view of the window.

Correct any errors before proceeding to step@ For port bypass:

a. Verify that the SFPs and GBICs or fibre channel cables are in good
condition.

b. Remove and reinsert SFPs, GBICs and fibre channel cables.

c. Make sure the new drive expansion enclosure fibre channel speed switch is
set to the same speed as the existing drive expansion enclosures and the
FASIT Storage Server fibre channel speed setting.

d. Verify that the ESM is good by physically removing and swapping it with the
other ESM in the same drive expansion enclosure. For enclosure ID conflict,
set the drive expansion enclosure ID switch to values unique from the
current settings in the existing drive expansion enclosures and storage
server.

Call the IBM Help Center in your geography for assistance if the problems
persist.

In the other drive loop (that is, drive loop B) in a FAStT Storage Server
redundant drive loop pair, remove the fibre channel connection from the storage
subsystem drive loop port to the OUT port of the last storage expansion
enclosure and connect it to the OUT port of the new drive enclosure as shown in
[Figure 6 on page 23

7. Wait a few seconds; verify that the port bypass LEDs of the two ports in the

fibre channel connection between the storage subsystem drive loop port and the
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OUT port of the new drive enclosure are not lit. Using the FASIT Storage
Manager Client Subsystem Management window, verify that the new drive
enclosure does not indicate the drive enclosure Tost redundancy path error.

See the preceding step |5 on page 37|for possible corrective actions, if needed.

In drive loop B, cable the new drive enclosure’s IN port to the OUT port of the
last enclosure in the already functioning storage expansion enclosure drive loop
as shown in|Figure 7 on page 24}

Wait a few seconds; verify that the port bypass LEDs of all of the ports in drive
loop B to which you have added a new fibre channel connection are not lit.
Using the FASET Storage Manager Client Subsystem Management window,
verify that all of the drive enclosures in the FAStT redundant drive loop pair to
which the new enclosure was added does not report the drive enclosure Tost
redundancy path error.

Activity 7: Inserting hard drives and placing logical drives online

1.

Insert the fibre channel drives into the empty drive slots in the new enclosure in
pairs. Wait until each drive pair has fully spun up and displayed in the FAStT
Storage Subsystem Management window before inserting the next drive pair.

For each additional enclosure that you that you intend to migrate to the
functioning drive loop pair, perform|Activity 5: Installing and setting storage]
expansion unit IDs and speeds| step|1 on page 36| through step [3 on page 36|
Activity 6: Cabling, powering on, and verifying storage expansion unit operation|

step|1 on page 37| through step|d, and step [1] of this activity. (See|Figure 8 ony

|9age 26[) When you have completed adding enclosures, proceed to step

As the FASET Storage Server recognizes the drives, it reads and displays the
array and logical drive information on the drives in the Logical/Physical view of
the FASIT Storage Subsystem Management window. The storage subsystem
places the array in offline state until it recognizes that you have inserted all of
the drives that comprise the array.

Once you insert all of the drives and the FAStT Storage Server recognizes
them, change the state of the arrays or logical drives to the online state by
right-clicking on the array name in the Storage Subsystem window and clicking
Place » Online.

If any of the following conditions persist, contact the IBM Help Center in your
geography for assistance.

e The empty drive slot icon (
inserted the migrating drive.

displayed for the drive slot into which you

* The Failed unconfigured drive icon ( @ ) or the Failed configured drive icon

( E ) displayed for the drive slot into which you inserted the migrating drive.
* Array configuration data on the drives you have added is incomplete.
* You cannot bring the array online.

Attention: Do not initialize a drive that you want to keep (by right-clicking its
icon and selecting Initialize from the pull-down menu) if it contains configuration
or user data. Initializing any of the drives in a defined array causes all hard
drives that comprise an array to return to the Unconfigured Capacity storage
pool, deleting their array definitions from the FAStT Storage Server
configuration. The user data on such drives is lost.
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Result: Once the arrays are online, they are ready for you to configure and
map to host servers. You might also then recreate flashcopies and remote
mirror relationships.

Use the FASLT Storage Manager program to view the storage partitioning
definitions and make any necessary corrections.

The FASHT Storage Server that the fibre channel drives are migrated from will
display the logical drives that are defined in these drives as “missing LUNSs”. In
order to remove these “missing LUNS” entries, right-click on each entry and
select Delete from the pull-down menu.
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Chapter 7. Upgrading a storage server in a functioning
configuration

This procedure details the steps that are required to upgrade a FASIT Storage
Server in a functioning FASET configuration. Where either an identical or newer
FASIT Storage Server model is involved, this upgrade involves only the
replacement of the FASLT storage controller to be upgraded. FASIT storage
expansion enclosures that had been attached to drives containing configuration
data are connected to the new FAStT Storage Server. The upgraded (original)
FASLT Storage Server being replaced will be either scrapped or returned to
operation (redeployed) at a later date with new drives and/or new storage
expansion enclosures. [Table 8 on page 42| illustrates what FAStT Storage Server
models you can use as replacements.

Preliminary considerations: Server upgrade

While upgrading a storage server in a functioning configuration, remain aware of
these important considerations:

* Observe proper ESD handling procedures when handling electronic equipment.

» IBM assigns premium feature entitlements only to specific FAStT storage servers.
In order to enable premium features in a replacement FAStT Storage Server
configuration that had been enabled in an original FAStT Storage Server
configuration, you must purchase appropriate entitlements for the replacement
FASIT Storage Server. In addition, IBM assigns host kits only to specific FAStT
storage servers. You must also purchase the appropriate host kits for new FAStT
storage servers.

» See the appropriate FAStT storage controller’s installation and user’s guide for
information on the proper power on or power off sequences.

Note: The remainder of this topic pertains to the original FASIT Storage Server that
is designated for replacement as either the original or old FAStT Storage
Server.

This task requires that you shutdown the FASIT Storage Server configuration. In
addition, after the upgrade, premium features previously enabled in the original
FAStT Storage Server along with the enable-by-default premium features in the new
FASIT Storage Server will automatically be placed in Out-of-Compliance state. Full
data availability is retained, but you must generate new premium feature SAFE keys
in order to re-enable premium features. You can generate new SAFE keys by
contacting the IBM Help Center in your geography. Be sure to have the necessary
proof of purchase. Alternately, you can also generate new SAFE keys by using
instructions located at the following Web site:

www.premiumfeatures.com|

The new FASIT Storage Server controller identifies itself using a new fibre channel
Worldwide Name (WWN) that is different from the WWN used by the original FAStT
Storage Server controller. For this reason, additional tasks might be required after
the upgrade for any host applications or drivers that rely on the WWNSs to identify
logical drives defined in a given FAStT Storage Server. See your application
program’s documentation, your driver’'s user guide, or related documentation for
detailed instructions on how to update the WWN of the FAStT Storage Server in the
application or driver. Additionally, review the readme file and the related IBM
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TotalStorage FASLT Storage Manager installation and support guide for information
about any preparation tasks required in addition or operating system-specific
restrictions. IBM TotalStorage FAStT Storage Manager installation and support
guides are located at the following Web site:

|www-1 .ibm.com/servers/storage/support/fastt/index.html|

associates FAStT Storage Server machine types with their supported
replacements.

Table 8. FASLT storage servers by supported replacement machine types

FAStT Storage Server machine Supported replacement FAStT Storage Server

type machine types

FAStT200 FAStT200, FAStT500, FAStT700, FAStT900

FAStT500 FAStT500, FAStT700, FAStT900, FAStT600
(60U/60X), FAStT600 Turbo (60U/60X)

FAStT600 Single Controller FAStT600 (6LU/6LX), FAStT600 (60U/60X),

(6LU/BLX) FAStT600 Turbo (60U/60X)

FAStT600 (60U/60X) FAStT500, FAStT600 (60U/60X), FAStT600 Turbo
(60U/60X), FAStT700, FAStT900

FAStT600 Turbo (60U/60X) FAStT500, FAStT600 (60U/60X), FAStT600 Turbo
(60U/60X), FAStT700, FAStT900

FAStT700 FAStT500, FAStT600 (60U/60X), FAStT600 Turbo
(60U/60X), FAStT700, FAStT900

FAStT900 FAStT500, FAStT600 (60U/60X), FAStT600 Turbo
(60U/60X), FAStT700, FAStT900

Attention:

» Migration to a FAStT600 Storage Server configuration from FAStT500, FAStT700
or FAStT900 Storage Server configurations with more than eight drive expansion
enclosures will require more than one FAStT600 Storage Server. See
lpage 1]

* FAStT600 and FAStT600 Turbo storage servers do not accommodate FAStT
EXP500 drive expansion enclosures. Do not migrate the EXP500 enclosures in

FAStT500, FAStT700 or FAStT900 Storage Server configurations to FAStT600 or
FAStT600 Turbo Storage Server configurations.

» Set the FASIT EXP700 storage expansion enclosure’s speed switch to 1 Gbps
when migrating from 2 Gbps configurations to a FAStT500 Storage Server 1
Gbps configuration.

* Never alter the physical configuration of a FAStT Storage Server while it is
powered off unless you are instructed to do so as part of a FAStT configuration
procedure. This includes both attaching and removing storage components from
a previously configured FAStT Storage Server.

Preliminary considerations: Firmware behavior during server upgrade

This section describes technical considerations regarding basic FAStT Storage
Server controller firmware behavior during a FAStT Storage Server upgrade. It
covers firmware behavior during system upgrade, where a new FAStT Storage
Server connects to functioning drives and storage expansion enclosures, as well as
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firmware behavior during system redeployment, where the original (old) FAStT
Storage Server serves as a logically distinct entity, optionally, using some of the
drives from the original system.

FAStT configuration behavior after upgrade and FAStT Storage Server

replacement

The new FASIT Storage Server that powers up in a functioning storage expansion
enclosure configuration as part of the FASIT Storage Server upgrade process
impacts the following areas of the FAST Storage Server identification and premium
features:

1.

Fibre Channel Worldwide Name (WWN):

The fibre channel worldwide names that were used by the original FAStT
Storage Server prior to the upgrade are not returned when the upgrade is
complete. Rather, the new FASIT Storage Server begins to advertise itself using
WWNs that are based on an embedded unique identifier from its controller
blades. This statement applies to both the fibre channel port WWNs and the
fibre channel node WWNs. Consequently, any hosts that were aware of the
logical drives in the original FAStT Storage Server based on the original FAStT
storage server's WWN values will likely be confused. The data volumes that
resided behind the previously known WWNSs now reside behind a seemingly
new fibre channel device with different WWNSs.

Storage Array Identifier (SAI or SA Identifier):

The storage array identifier, or SA Identifier, is the identification value used by
the FASIT Storage Manager host software (SMclient) to uniquely identify
managed storage servers. The FASIT Storage Manager SMclient program
maintains SA Identifier records of previously discovered storage servers in the
host resident file, which allows it to retain discovery information in a persistent
fashion. This identifier is stored on DACstore, and persists across reboots,
power cycles, and so on. The new FASIT Storage Server that powers up in a
functioning storage expansion enclosure configuration as part of the FAStT
Storage Server upgrade process continues to use the SA Identifier of the
original FASIT Storage Server.

SAFE Premium Feature Identifier (SAFE ID) and Premium Feature Enable
Status:

The new FASHT Storage Server retains the SAFE ID of the original FAStT
Storage Server. It also retains all of the features previously enabled on the
original FAStT Storage Server. The feature states, however, are set to the
Out-of-Compliance state. As a result, the system sends alert notices and
establishes a Needs Attention condition. Also, any features that are marked in
the new controller's NVSRAM for automatic enablement are enabled, though
their feature states are also set to Out-of-Compliance. You must re-enable the
premium features by using premium feature SAFE key files.

Redeployed FASIT configuration behavior in an original (replaced)
FAStT Storage Server

When you redeploy FAStT Storage Server hardware in another FASLT storage
server’s configuration, identification and premium features of the redeployed system
behave somewhat differently from information described in|[‘FAStT configuration|

behavior after upgrade and FAStT Storage Server replacement.’] This section

describes those relevant behavioral differences.
» Fibre Channel Worldwide Name (WWN):
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The fibre channel worldwide names that were used by the original FAStT Storage
Server are retained on the redeployed system. These values are based on an
embedded unique identifier from the original FAStT Storage Server controller
blades, and are stored in the NVSRAM on each controller board within the
controller blade. Assuming that both controllers remain fully optimal after the
redeployment, they recognize the stored value and continue to use it.
Consequently, any hosts that were aware of the original FAStT Storage Server,
based on its fibre channel WWN values, will likely be confused. The logical
drives that used to reside behind the previously-known WWNSs no longer reside
there, because they are now part of the new FASIT Storage Server, which has a
different WWN.

» Storage Array Identifier or SA Identifier:

If you return one or more drives that were originally moved from a FAStT Storage
Server back to the original FASIT Storage Server configuration before it is
redeployed, it is possible that the SA Identifier that was used on the original
FASIT Storage Server system will also be reused in the redeployed FAStT
Storage Server configuration. Whether or not this occurs depends on the specific
selection of transported drives. If certain conditions are met, however, the
redeployed unit adopts the same SA Identifier that was retained by the new
FASIT Storage Server. Otherwise, or in cases in which only new drives are used
in the redeployed configuration, the redeployed FAStT Storage Server generates
a new (and unique) SA ldentifier that does not conflict with the one that was
retained by the upgraded unit.

If both the new and the redeployed FASIT Storage Server have the same SA
Identifier, serious problems will result when you start the FASIT Storage Manager
SMclient program. Since there will be two FAStT storage servers with the same
SA Identifier, the FAStT Storage Manager SMclient program will respond by
arbitrarily selecting either the new or the redeployed FAStT Storage Server. The
storage server that the FAStT Storage Manager SMclient program arbitrarily
selects will be manageable, and the other storage server will be unmanageable.

* SAFE Premium Feature Identifier (SAFE ID)
Premium Feature Enable status:

If you return any drives from an original FAStT Storage Server, along with the
original FASIT Storage Server controllers, to a redeployed FAStT configuration,
the SAFE ID of the original FAStT Storage Server will be retained, and all
enabled features will remain fully enabled and compliant.

If you do not move any drives from an original FAStT Storage Server, it
generates a new SAFE ID when redeployed, enabling none of the premium
features from the original system. This new SAFE ID prevents the system from
using any previously-acquired SAFE key files and re-enabling any premium
features. In cases where the original FASIT Storage Server was pre-loaded with
NVSRAM codes to enable certain premium features, NVSRAM codes are cleared
from the FASIT Storage Server when redeployed and powered on for the first
time. Therefore, premium features that were considered every unit items do not
reactivate on the redeployed system. The system retains full data availability, but
you must generate new premium feature SAFE keys in order to re-enable
premium features. You can generate new SAFE keys by contacting the IBM Help
Center in your geography. Be sure to have the necessary proof of purchase.
Alternately, you can also generate new SAFE keys by using instructions located
at the following Web site:

[www.premiumfeatures.com|
» Controller IP addresses:
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When the FASLT Storage Server controllers were assigned static IP addresses,
the IP addresses were stored in the NVSRAM of the controller board as well as
the DACstore on the fibre channel disks. If the new (replacement) FAStT Storage
Server controllers were assigned the same IP addresses as the original
(replaced) FASIT Storage Server controllers, network problem will arise when the
original (replaced) FAStT Storage Server is eventually redeployed . The problem
will occur because two devices have the same IP address in the Ethernet
network. The best practice is to assign new unique IP addresses to new
(replacement) FASIT Storage Server controllers instead of using the same IP
addresses as the FASIT controllers that they replace.

Upgrading storage servers in functioning FASIT configurations

Before you perform the following upgrade procedure, review and perform the steps

de

tailed in [Chapter 2, “Prerequisites to adding capacity and hard drive migration,”|

Ign page 9.

Complete the following activities to upgrade your FAStT Storage Server:

Activity 1: Preliminary activities
Perform the following steps before you disconnect storage expansion enclosures

fro

m an original FAStT Storage Server that is being replaced to ensure a successful

FAStT Storage Server upgrade.

1.

Verify that the original FAStT storage server’s controller firmware and
NVSRAM are at the levels shown in[Table 6 on page 10}

Verify that the firmware of the ESMs in the storage expansion enclosures is at
the levels shown in [Table 7 on page 11}

Disable or delete any flashcopies of the logical drives.
Delete any remote mirror relationships.

If the arrays (logical drives) are not in optimal state, perform the steps
necessary to bring the arrays (logical drives) into their optimal state before
you attempt their migration. See the FAStT Problem Determination Guide
associated with your particular FAStT hardware model or[‘Bringing storage|
lsubsystems and drive loops into optimal state” on page 12| for additional
information on how to make this determination.

If the drive enclosures are not in optimal state, perform the steps necessary to

bring them to optimal state before attempting migration. Perform the following

steps to verify that the drive loops are in optimal state:

a. Physically trace the actual fibre channel cable connections making sure
that fibre channel connections are properly modified and that the fibre
channel cable connectors are firmly inserted into the SFPs or GBICs.

b. Verify that the following LEDs are not lit or briefly flashed in the modified
drive loop:

* ESM fault
» port bypass
* ID conflict

c. Verify that the controller drive loop LED remains lit. If the controller drive
loop LED becomes unlit momentary, there are problems in the drive loop
and the fibre channel LIPs are generated by the FAStT Storage Server
controller.
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d. In the FASIT Storage Manager Client Subsystem Management window,
verify that there are no Toss of ESM path redundancy errors in the drives
expansion enclosures that are not migrated.

Do not modify the second drive loop in a redundant drive loop pair until
you are sure that the first modified drive loop is operating optimally. See
the FAStT Problem Determination Guide associated with your particular
FASIT hardware model or [‘Bringing storage subsystems and drive Ioops|
|into optimal state” on page 12[for additional information on how to make
this determination.

7. Perform a full backup of the original FAStT Storage Server and schedule it for

down time. This is necessary because you must power down the FASIT
Storage Server configuration during the upgrade procedure.

8. Save the FASLT storage subsystem profile of the original FAStT Storage Server
configuration in a location other than that in which the logical drives are
defined in the original FAStT Storage Server configuration.

9. Stop all programs, services or processes in the host servers that access the
logical drives defined in the migrated hard drives. Make sure that there are not
any running background programs, services or processes that write data to the
logical drives. (For example, Microsoft MSCS service periodically writes to the
“Quorum” disk.)

10. Unmount the file systems to flush 1/O from the server cache to disks.

Notes:

a. In a Microsoft Windows environment, remove the drive letter or the mount
points of the mapped LUNSs instead of unmounting the file systems.

b. Consult documentation associated with your particular operating system for
detailed information regarding the Unmount procedure.

11. Place the arrays defined on the FASIT Storage Server in off1ine state. In the
Storage Subsystem Management window, right-click on the name of the array
and select Place » Offline.

12. Retrieve proofs of purchase for both the original and new FASLT storage
servers and for the additional premium feature entitlements on the new and
original FAStT storage servers. IBM support personnel will require this
information to regenerate premium feature SAFE key files that were enabled in
the original FAStT Storage Server for use on the new FASIT Storage Server.

Activity 2: Powering off the original FAStT Storage Server

Power down the original FAStT Storage Server and remove it from the FAStT
configuration. Do not redeploy this FAStT Storage Server in the same management
domain as its upgrade (replacement) FASIT Storage Server until you regenerate its
SA identifier using the instructions in |“Redep|oying the original (replaced) FAStTl
[Storage Server” on page 48|

Note: See the appropriate FASIT storage controller’s installation and user’s guide
for details on the correct power off sequence.

Activity 3: Installing new FAStT Storage Servers and setting minihub

speed
Install the new FAStT Storage Server. For FAStT700 and FAStT900 Storage Server
machine types, set the drive minihub speed switch to the speed of the storage
expansion enclosure ports to which they are connected.
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Note: The FAStT600 drive loop port operates only at 2 Gbps. If you migrate

storage expansion enclosures from a 1 Gbps fibre channel environment to a
2 Gbps fibre channel environment, do not automatically change the storage
expansion enclosure speed settings from 1 Gbps to 2 Gbps. Before you do,
verify that each fibre channel drive involved is capable of 2 Gbps operation
and that you have installed the latest firmware enabling them to work
properly in a 2 Gbps fibre channel environment.

Important: If the new FASIT Storage Server is either a FAStT200 or FAStT600
Storage Server machine type, set the FAStT200 or FAStT600 enclosure ID to a
value unique from other EXP storage expansion enclosures in the fibre channel
drive loop. These IDs are normally set to “0” at the factory.

Activity 4: Making fibre channel connections

Insert the SFPs or GBICs into the FAStT Storage Server drive port slots and make
the fibre channel connections from the FAStT Storage Server to the storage
expansion enclosures. For detailed information, see the appropriate FASIT storage
controller’s installation and user guide.

Activity 5: Powering on the expansion unit and setting IP addresses

1.

Verify that all of the storage expansion enclosures are powered on and in
optimal state by examining the expansion enclosure LED states. Then, power
on the new FAStT Storage Server. Using the FASIT Storage Manager client
program, verify that the FAStT Storage Server is operational and that all of the
drives are recognized and in optimal state. See the FAStT Problem
Determination Guide associated with your particular FAStT hardware model or

[‘Bringing storage subsystems and drive loops into optimal state” on page 12| for

additional information on how to make this determination.

Notes:

a.

Your storage subsystem will identify the new FAStT Storage Server as the
machine type it replaced until you download the appropriate NVSRAM file
for the new storage server. For example, if you replace a FAStT500 with a
FAStT900, the FAStT900 will be reported as machine type FAStT500 until
you download the appropriate NVSRAM file for the FAStT900.

See the appropriate FASIT storage controller’s installation and user guide for
information on the proper power on sequence.

If the new FASLT Storage Server is managed out-of-band, perform the steps for
setting the IP addresses for new FASIT Storage Server controllers defined in the
IBM TotalStorage FAStT Storage Manager installation and support guide
associated with your operating system environment. FAStT Storage Manager
installation and support guides are located at the following Web site:

[www-1.ibm.com/servers/storage/support/fastt/index.html|

Activity 6: Downloading firmware and NVSRAM and returning arrays

online

1.

Use the FASIT Storage Manager client program to download the firmware and
the NVSRAM for the new FAStIT Storage Server.

Return the offline arrays to online state by right-clicking on the array and
selecting Place » Online. If any of the following conditions persist, contact the
IBM Help Center in your geography for assistance:
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* The empty drive slot icon (
inserted the migrating drive.

displayed for the drive slot into which you

e The Failed unconfigured drive icon ( @ ) or the Failed configured drive icon

( E ) displayed for the drive slot into which you inserted the migrating drive.
» Array configuration data on the drives you have added is incomplete.
* You cannot bring the array online.

Activity 7: Generating and applying premium feature SAFE key files

Generate the new premium feature SAFE key files using the new FASIT Storage
Server Feature Enable Identifier. Apply premium feature SAFE keys to remove
Qut-of-Compliance errors on enabled premium features.

Result: You are now able to recreate flashcopies and remote mirror relationships, if
required.

Redeploying the original (replaced) FAStT Storage Server

Accessing the

As a safety measure, force generation of a new SA Identifier when you redeploy an
original (replaced) FAStT Storage Server. Use the controller shell commands to
generate a new SA ldentifier. To gain access to the controller shell, you will require
a null modem cable and a terminal emulation program that is capable of sending a
BREAK signal. The setting for the terminal emulation session is 8-N-1 (8 data bits, no
parity bit and 1 stop bit). Once you enter the controller shell, use the following
command sequence to force the controller to generate a new SA Identifier:

1d </Debug
symbolGenerateNewSAIdentifier

Note: It is necessary for you to run this command sequence on only one controller.
Then, reset both FAStT Storage Server controllers and proceed with the normal
FASLT Storage Server installation and configuration process.

FAStT Storage Server controller shell

The following steps describe how to access the FASIT Storage Server controller
shell using the terminal emulation program of your choice. One example of such a
terminal emulation program for which IBM neither makes nor implies a warranty,
HyperTerminal, Private Edition; version 6.3 or higher, is available for your
consideration at the following Web site:

www.hilgraeve.com|

A generic version of steps involved in accessing the FASIT Storage Server
controller shell using the terminal emulation program of your choice follows:

1. Stop all I/O on the FASIT Storage Server.

2. Connect a null modem serial cable from one of the FASIT Storage Server
controller communications (COM) ports to a system with an available terminal
emulator.

3. Open the terminal emulation program of your choice, such as the
HyperTerminal, Private Edition program and from the menu bar, click File -
Properties » Configure. Establish the following property settings:

» Bits per second: 57600
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10.

» Data bits: 8

* Parity: None

« Stop Bit: 1

* Flow Control: None

Connect to the FASIT Storage Server controller shell by sending a BREAK
signal. (If you are using the HyperTerminal, Private Edition program, press the
Ctr1 and BREAK keys simultaneously to send the BREAK signal.)

Repeat step until the following message displays:
“Press the space bar for baud rate within 5 seconds.”

Press the space bar within the time limit to establish the correct baud rate
setting.

Send another BREAK signal. The following message is displayed:
“Press within 5 seconds: ESC for SHELL, BREAK for baud rate.”
Press the ESC key within the time limit to access the controller shell.
When prompted, type the following password:

infiniti

You are now accessing the FAStT Storage Server controller shell.

Important: Be careful when entering commands in the FAStT Storage Server
controller shell. Improper use of FAStT Storage Server controller shell
commands could result in loss of configuration data.
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Appendix. Additional FAStT documentation

The following tables present an overview of the FAStT900, FAStT700, and
FAStT600 Fibre Channel Storage Server product libraries, as well as other related
documents. Each table lists documents that are included in the libraries and what
common tasks they address. Click on active links in the tables to access those
documents currently available on the Internet. You can access documentation for

the other FASIT products at the following Web site:

issddom02.storage.ibm.com/techsup/webnav.nsf/support/fastt/|

FAStT900 Fibre Channel Storage Server library

associates each document in the FAStT900 Fibre Channel Storage Server
library with its related common user tasks.

Table 9. TotalStorage FAStT900 Fibre Channel Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotaIStorage|
FAStT900

Installation and
Support Guide,

GC26-7530]

IBM TotalStorage
FAStT900 Fibre
Channel Cablin
Instructions,
24P8135

IBM TotaIStorage|

FAStT900 Storage]
Server User's|
Guide, GC26-7534

IBM TotaIStorage|

FAStT FC2-133 Dual|
Port Host Bus|
Adapter Installation|
and User’s Guide,|

GC26-7532f

IBM FAStT FC2-133
Host Bus Adaptet|
Installation and
User's Guide,
48P9823

IBM TotalStorag
FAStT900 Rack
Mountin
Instructions,
19K0900

0]
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf

Table 9. TotalStorage FAStT900 Fibre Channel Storage Server document titles by user tasks (continued)

Title User Tasks
Planning |Hardware Software Configuration |Operation and |Diagnosis and
Installation Installation Administration | Maintenance
IBM Fibre Channel|
Planning and
Integration: User’s|
Guide and Service| v v v v
Information,
SC23-432
IBM FASLT]
Management Suite
Java User’s Guide, v v
32P0081|
IBM TotalStorage
FASLT Fibre
Channel Hardware W
Maintenance
Manual, GC26-7640
IBM TotalStorage
FAStT Fibre
Channel Problem P

Determination
Guide, GC26-7642

52  Adding and Migrating Drives and Expansion Enclosures to FAStT Storage Servers


http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf

FAStT700 Fibre Channel Storage Server library

associates each document in the FAStT700 Fibre Channel Storage Server
library with its related common user tasks.

Table 10. TotalStorage FAStT700 Fibre Channel Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM FAStT700
Installation and
Support Guide,
32P0171

IBM FAStT700 Fibrel
Channel Cablin
Instructions,|
32P0343

IBM FAStT700 Fibre|
Channel Storage
Server User’'s
Guide, 32P0341

IBM FAStT FC2-133
Dual Port Host Bus|
Adapter Installation|
and User’s Guide,|

GC26-7532f

IBM TotaIStorage|

FAStT FC2-133 Host|
Bus Adapte

IBM FASHT]

Management Suite
Java User’s Guide,

32P0081|

IBM TotalStorage
FASLT Fibre
Channel Hardware
Maintenance
Manual, GC26-7640

IBM TotalStorage
FAStT Fibre
Channel Problem
Determination
Guide, GC26-7642
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0171.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0171.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0171.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0171.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf

FAStT600 Fibre Channel Storage Server library

able 11|associates each document in the FAStT600 Fibre Channel Storage Server
library with its related common user tasks.

Table 11. TotalStorage FAStT600 Fibre Channel Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStorage
FAStT600 Fibre
Channel Storage|

Server Installation]|
land User’s Guide,|

GC26-7531]

IBM TotalStorage
FASLT Fibre
Channel Hardware
Maintenance
Manual, GC26-7640

IBM TotalStorage
FAStT Fibre
Channel Problem
Determination
Guide, GC26-7642

IBM TotaIStorage|

FAStT FC2-133 Dual|
Port Host Bus|
[Adapter Installation|
and User’s Guide,|

GC26-7532f

IBM TotalStorage
FAStT600 Rack
Mounting
Instructions,
24P8125

IBM TotalStorage
FAStT600 Cabling
Instructions,
24P8126
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf

FAStT-related documents
associates each of the following documents related to FAST operations

with its related common user tasks.

Table 12. TotalStorage FAStT related document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM Safety
Information,
P48P9741

’/

IBM TotaIStora?e|
FAStT EXP100
Storage Expansion|
Unit Release Notes,|

GC26-7619

IBM TotaIStora?el
FAStT EXP100
Storage Expansion|
Unit Installation and|

Users Guide,
GC26-7601

U

Fibre Channel
Solutions - IBM
FAStT EXP500
Installation and

User's Guide,
59p5637|

IBM EXP700
Storage Expansion|
Unit Installation and|
User's Guide,
32P0178

IBM Netfinity® Fibre]
Channel Cabling
Instructions,
19K0906,

IBM Fibre Channell
SAN Configuration|
Setup Guide,
25P2509
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8851.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8851.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8851.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8851.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8851.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
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Notices

This publication was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM® may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Trademarks

The following terms are trademarks of International Business Machines Corporation
in the United States, other countries, or both:

FlashCopy Netfinity
IBM ServerProven
IBMLink TotalStorage
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Intel is a trademark of Intel Corporation in the United States, other countries, or
both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.

Important notes

Processor speeds indicate the internal clock speed of the microprocessor; other
factors also affect application performance.

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often
less than the maximum possible.

When referring to processor storage, real and virtual storage, or channel volume,
KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000
bytes, and GB stands for approximately 1 000 000 000 bytes.

When referring to hard disk drive capacity or communications volume, MB stands
for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible
capacity may vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the largest
currently supported drives available from IBM.

Maximum memory may require replacement of the standard memory with an
optional memory module.

IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven®, including but not limited to the implied warranties
of merchantability and fitness for a particular purpose. These products are offered
and warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software may differ from its retail version (if available), and may not include
user manuals or all program functionality.

Electronic emission notices

This section gives the electronic emission notices or statements for the United
States and other countries or regions.

Federal Communications Commission (FCC) statement

Note: This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio
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communications. Operation of this equipment in a residential area is likely to cause
harmful interference, in which case the user will be required to correct the
interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to
meet FCC emission limits. Properly shielded and grounded cables and connectors
must be used in order to meet FCC emission limits.IBM is not responsible for any
radio or television interference caused by using other than recommended cables
and connectors or by using other than recommended cables and connectors or by
unauthorized changes or modifications to this equipment. Unauthorized changes or
modifications could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

Chinese class A compliance statement

Attention: This is a class A statement. In a domestic environment, this product
might cause radio interference in which case the user might be required to take
adequate measures.

i A RAFIE “Adl” EEEH

|
SNAS AR, EAFEREY, B RA RS ENTAET . EXHEAT,
T R E R PO TR RN AT A

Industry Canada Class A emission compliance statement
This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité a la réglementation d’Industrie Canada

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du
Canada.

Australia and New Zealand Class A statement

Attention: This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate
measures.

United Kingdom telecommunications safety requirement
Notice to Customers

This apparatus is approved under approval number NS/G/1234/J/100003 for indirect
connection to public telecommunication systems in the United Kingdom.

European Union EMC Directive conformance statement

This product is in conformity with the protection requirements of EU Council
Directive 89/336/EEC on the approximation of the laws of the Member States
relating to electromagnetic compatibility. IBM cannot accept responsibility for any
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failure to satisfy the protection requirements resulting from a nonrecommended
modification of the product, including the fitting of non-IBM option cards.

This product has been tested and found to comply with the limits for Class A
Information Technology Equipment according to CISPR 22/European Standard EN
55022. The limits for Class A equipment were derived for commercial and industrial
environments to provide reasonable protection against interference with licensed
communication equipment.

Attention: This is a Class A product. In a domestic environment this product may

cause radio interference in which case the user may be required to take adequate
measures.

Taiwan Class A warning statement

e

BATFTRAMATRAES &
AR IR P AE A B o 7T
RREdRAE TR A2
AEERT AR
P ETITETE

\.:

Japanese Voluntary Control Council for Interference (VCCI) statement

ZOLE T, F B E SRR EE A EAH#ES (VCC 1) DRUEL
$o< 7 77\Afﬁ§&&f’ﬁ %Tff Z OE  FRERET TIN5 LB E A
FISRIFTZLnDY 3, ZOLEITIIHHE R ED 20w/ 275 £ 9 2k
SNDHZLENHY ET,
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Glossary

This glossary provides definitions for the
terminology used for the IBM TotalStorage FAStT.
This glossary also provides definitions for the
terminology used for the IBM TotalStorage FAStT
Storage Manager.

This glossary defines technical terms and
abbreviations used in this document. If you do not
find the term you are looking for, see the IBM
Glossary of Computing Terms located at
www.ibm.com/networking/nsg/nsgmain.htm

This glossary also includes terms and definitions
from:

» Information Technology Vocabulary by
Subcommittee 1, Joint Technical Committee 1,
of the International Organization for
Standardization and the International
Electrotechnical Commission (ISO/IEC
JTC1/SCH1). Definitions are identified by the
symbol (l) after the definition; definitions taken
from draft international standards, committee
drafts, and working papers by ISO/IEC
JTC1/SC1 are identified by the symbol (T) after
the definition, indicating that final agreement
has not yet been reached among the
participating National Bodies of SC1.

* IBM Glossary of Computing Terms. New York:
McGraw-Hill, 1994.

The following cross-reference conventions are
used in this glossary:

See Refers you to (a) a term that is the
expanded form of an abbreviation or
acronym, or (b) a synonym or more
preferred term.

See also
Refers you to a related term.

Abstract Windowing Toolkit (AWT). A Java graphical
user interface (GUI).

accelerated graphics port (AGP). A bus specification
that gives low-cost 3D graphics cards faster access to
main memory on personal computers than the usual
peripheral component interconnect (PCI) bus. AGP
reduces the overall cost of creating high-end graphics
subsystems by using existing system memory.

access volume. A special logical drive that allows the
host-agent to communicate with the controllers in the
storage subsystem.

© Copyright IBM Corp. 2004

adapter. A printed circuit assembly that transmits user
data input/output (I/0O) between the internal bus of the
host system and the external fibre-channel (FC) link and
vice versa. Also called an I/O adapter, host adapter, or
FC adapter.

advanced technology (AT) bus architecture. A bus
standard for IBM compatibles. It extends the XT bus
architecture to 16 bits and also allows for bus
mastering, although only the first 16 MB of main
memory are available for direct access.

agent. A server program that receives virtual
connections from the network manager (the client
program) in a Simple Network Management
Protocol-Transmission Control Protocol/Internet Protocol
(SNMP-TCP/IP) network-managing environment.

AGP. See accelerated graphics port.
AL_PA. See arbitrated loop physical address.

arbitrated loop. One of three existing fibre-channel
topologies, in which 2 - 126 ports are interconnected
serially in a single loop circuit. Access to the Fibre
Channel-Arbitrated Loop (FC-AL) is controlled by an
arbitration scheme. The FC-AL topology supports all
classes of service and guarantees in-order delivery of
FC frames when the originator and responder are on
the same FC-AL. The default topology for the disk array
is arbitrated loop. An arbitrated loop is sometimes
referred to as a Stealth Mode.

arbitrated loop physical address (AL_PA). An 8-bit
value that is used to uniquely identify an individual port
within a loop. A loop can have one or more AL_PAs.

array. A set of fibre-channel hard drives that are
logically grouped together to form a redundant array of
independent disks (RAID) set.

AT. See advanced technology (AT) bus architecture.
ATA. See AT-attached.

AT-attached. Peripheral devices that are compatible
with the original IBM AT computer standard in which
signals on a 40-pin AT-attached (ATA) ribbon cable
followed the timings and constraints of the Industry
Standard Architecture (ISA) system bus on the IBM PC
AT computer. Equivalent to integrated drive electronics
(IDE).

auto-volume transfer/auto-disk transfer (AVT/ADT).
A function that provides automatic failover in case of
controller failure on a storage subsystem.

AVT/ADT. See auto-volume transfer/auto-disk transfer.

AWT. See Abstract Windowing Toolkit.
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basic input/output system (BIOS). The personal
computer code that controls basic hardware operations,
such as interactions with diskette drives, hard disk
drives, and the keyboard.

BIOS. See basic input/output system.
BOOTP. See bootstrap protocol.

bootstrap protocol (BOOTP). In Transmission Control
Protocol/Internet Protocol (TCP/IP) networking, an
alternative protocol by which a diskless machine can
obtain its Internet Protocol (IP) address and such
configuration information as IP addresses of various
servers from a BOOTP server.

bridge. A storage area network (SAN) device that
provides physical and transport conversion, such as
fibre channel to small computer system interface (SCSI)
bridge.

bridge group. A bridge and the collection of devices
connected to it.

broadcast. The simultaneous transmission of data to
more than one destination.

cathode ray tube (CRT). A display device in which
controlled electron beams are used to display
alphanumeric or graphical data on an
electroluminescent screen.

client. A computer system or process that requests a
service of another computer system or process that is
typically referred to as a server. Multiple clients can
share access to a common server.

command. A statement used to initiate an action or
start a service. A command consists of the command
name abbreviation, and its parameters and flags if
applicable. A command can be issued by typing it on a
command line or selecting it from a menu.

community string. The name of a community
contained in each Simple Network Management
Protocol (SNMP) message.

CRC. See cyclic redundancy check.
CRT. See cathode ray tube.
CRU. See customer replaceable unit.

customer replaceable unit (CRU). An assembly or
part that a customer can replace in its entirety when any
of its components fail. Contrast with field replaceable
unit (FRU).

cyclic redundancy check (CRC). (1) A redundancy
check in which the check key is generated by a cyclic
algorithm. (2) An error detection technique performed at
both the sending and receiving stations.

dac. See disk array controller.

dar. See disk array router.
DASD. See direct access storage device.

default host group. A logical collection of discovered
host ports, defined host computers, and defined host
groups in the storage-partition topology that fulfill the
following requirements:

= Are not involved in specific logical drive-to-LUN
mappings

+ Share access to logical drives with default logical
drive-to-LUN mappings

device type. Identifier used to place devices in the
physical map, such as the switch, hub, or storage.

DHCP. See Dynamic Host Configuration Protocol.

direct access storage device (DASD). A device in
which access time is effectively independent of the
location of the data. Information is entered and retrieved
without reference to previously accessed data. (For
example, a disk drive is a DASD, in contrast with a tape
drive, which stores data as a linear sequence.) DASDs
include both fixed and removable storage devices.

direct memory access (DMA). The transfer of data
between memory and an input/output (I/O) device
without processor intervention.

disk array controller (dac). A disk array controller
device that represents the two controllers of an array.
See also disk array router.

disk array router (dar). A disk array router that
represents an entire array, including current and
deferred paths to all logical unit numbers (LUNSs) (hdisks
on AIX). See also disk array controller.

DMA. See direct memory access.

domain. The most significant byte in the node port
(N_port) identifier for the fibre-channel (FC) device. It is
not used in the fibre channel-small computer system
interface (FC-SCSI) hardware path ID. It is required to
be the same for all SCSI targets logically connected to
an FC adapter.

DRAM. See dynamic random access memory.

Dynamic Host Configuration Protocol (DHCP). A
protocol defined by the Internet Engineering Task Force
that is used for dynamically assigning Internet Protocol
(IP) addresses to computers in a network.

dynamic random access memory (DRAM). A
storage in which the cells require repetitive application
of control signals to retain stored data.

ECC. See error correction coding.

EEPROM. See electrically erasable programmable
read-only memory.
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EISA. See Extended Industry Standard Architecture.

electrically erasable programmable read-only
memory (EEPROM). A type of memory chip which can
retain its contents without consistent electrical power.
Unlike the PROM which can be programmed only once,
the EEPROM can be erased electrically. Because it can
only be reprogrammed a limited number of times before
it wears out, it is appropriate for storing small amounts
of data that are changed infrequently.

electrostatic discharge (ESD). The flow of current
that results when objects that have a static charge
come into close enough proximity to discharge.

environmental services monitor (ESM) canister. A
component in a drive enclosure that monitors the
environmental condition of the components in that
enclosure. Not all storage subsystems have ESM
canisters.

E_port. See expansion port.

error correction coding (ECC). A method for
encoding data so that transmission errors can be
detected and corrected by examining the data on the
receiving end. Most ECCs are characterized by the
maximum number of errors they can detect and correct.

ESD. See electrostatic discharge.

ESM canister. See environmental services monitor
canister.

EXP. See expansion unit.

expansion port (E_port). A port that connects the
switches for two fabrics.

expansion unit (EXP). A feature that can be
connected to a system unit to provide additional storage
and processing capacity.

Extended Industry Standard Architecture (EISA). A
bus standard for IBM compatibles that extends the
Industry Standard Architecture (ISA) bus architecture to
32 bits and allows more than one central processing
unit (CPU) to share the bus. See also Industry Standard
Architecture.

fabric. A Fibre Channel entity which interconnects and
facilitates logins of N_ports attached to it. The fabric is
responsible for routing frames between source and
destination N_ports using address information in the
frame header. A fabric can be as simple as a
point-to-point channel between two N-ports, or as
complex as a frame-routing switch that provides multiple
and redundant internal pathways within the fabric
between F_ports.

fabric port (F_port). In a fabric, an access point for
connecting a user's N_port. An F_port facilitates N_port

logins to the fabric from nodes connected to the fabric.
An F_port is addressable by the N_port connected to it.
See also fabric.

FAStT MSJ. See FAS!T Management Suite Java.

FAStT Management Suite Java (FAStT MSJ). A
diagnostic and configuration utility that can be used on
Linux, Microsoft Windows, and Novell NetWare host
systems. In Linux, it is also used with the QLRemote
agent to define preferred and non-preferred paths for
logical drives.

FC. See fibre channel.
FC-AL. See arbitrated loop.

feature enable identifier. A unique identifier for the
storage subsystem, which is used in the process of
generating a premium feature key. See also premium
feature key.

fibre channel (FC). A set of standards for a serial
input/output (1/0) bus capable of transferring data
between two ports at up to 100 Mbps, with standards
proposals to go to higher speeds. FC supports
point-to-point, arbitrated loop, and switched topologies.

Fibre Channel-Arbitrated Loop (FC-AL). See
arbitrated loop.

Fibre Channel Protocol (FCP) for small computer
system interface (SCSI). A high-level fibre-channel
mapping layer (FC-4) that uses lower-level fibre-channel
(FC-PH) services to transmit SCSI commands, data,
and status information between a SCSI initiator and a
SCSI target across the FC link by using FC frame and
sequence formats.

field replaceable unit (FRU). An assembly that is
replaced in its entirety when any one of its components
fails. In some cases, a field replaceable unit might
contain other field replaceable units. Contrast with
customer replaceable unit (CRU).

FlashCopy. A premium feature for FASIT that can
make an instantaneous copy of the data in a volume.

F_port. See fabric port.
FRU. See field replaceable unit.
GBIC. See gigabit interface converter

gigabit interface converter (GBIC). A transceiver that
performs serial, optical-to-electrical, and
electrical-to-optical signal conversions for high-speed
networking. A GBIC can be hot swapped. See also
small form-factor pluggable.

graphical user interface (GUI). A type of computer
interface that presents a visual metaphor of a real-world
scene, often of a desktop, by combining high-resolution
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graphics, pointing devices, menu bars and other menus,
overlapping windows, icons, and the object-action
relationship.

GUI. See graphical user interface.
HBA. See host bus adapter.

hdisk. An AIX term representing a logical unit number
(LUN) on an array.

host. A system that is directly attached to the storage
subsystem through a fibre-channel input/output (1/O)
path. This system is used to serve data (typically in the
form of files) from the storage subsystem. A system can
be both a storage management station and a host
simultaneously.

host bus adapter (HBA). An interface between the
fibre-channel network and a workstation or server.

host computer. See host.

host group. An entity in the storage partition topology
that defines a logical collection of host computers that
require shared access to one or more logical drives.

host port. Ports that physically reside on the host
adapters and are automatically discovered by the FAStT
Storage Manager software. To give a host computer
access to a partition, its associated host ports must be
defined.

hot swap. To replace a hardware component without
turning off the system.

hub. In a network, a point at which circuits are either
connected or switched. For example, in a star network,
the hub is the central node; in a star/ring network, it is
the location of wiring concentrators.

IBMSAN driver. The device driver that is used in a
Novell NetWare environment to provide multipath
input/output (1/0) support to the storage controller.

IC. See integrated circuit.
IDE. See integrated drive electronics.

in-band. Transmission of management protocol over
the fibre-channel transport.

Industry Standard Architecture (ISA). Unofficial
name for the bus architecture of the IBM PC/XT
personal computer. This bus design included expansion
slots for plugging in various adapter boards. Early
versions had an 8-bit data path, later expanded to 16
bits. The "Extended Industry Standard Architecture”
(EISA) further expanded the data path to 32 bits. See
also Extended Industry Standard Architecture.

initial program load (IPL). The initialization procedure
that causes an operating system to commence
operation. Also referred to as a system restart, system
startup, and boot.

integrated circuit (IC). A microelectronic
semiconductor device that consists of many
interconnected transistors and other components. ICs
are constructed on a small rectangle cut from a silicon
crystal or other semiconductor material. The small size
of these circuits allows high speed, low power
dissipation, and reduced manufacturing cost compared
with board-level integration. Also known as a chip.

integrated drive electronics (IDE). A disk drive
interface based on the 16-bit IBM personal computer
Industry Standard Architecture (ISA) in which the
controller electronics reside on the drive itself,
eliminating the need for a separate adapter card. Also
known as an Advanced Technology Attachment
Interface (ATA).

Internet Protocol (IP). A protocol that routes data
through a network or interconnected networks. IP acts
as an intermediary between the higher protocol layers
and the physical network.

Internet Protocol (IP) address. The unique 32-bit
address that specifies the location of each device or
workstation on the Internet. For example, 9.67.97.103 is
an IP address.

interrupt request (IRQ). A type of input found on
many processors that causes the processor to suspend
normal processing temporarily and start running an
interrupt handler routine. Some processors have several
interrupt request inputs that allow different priority
interrupts.

IP. See Internet Protocol.

IPL. See initial program load.

IRQ. See interrupt request.

ISA. See Industry Standard Architecture.

isolated group. A collection of isolated devices not
connected to the storage area network (SAN) but
discovered by the SANavigator tool. The isolated group
displays with a gray background near the bottom of the
Physical and Data Path maps.

Java Runtime Environment (JRE). A subset of the
Java Development Kit (JDK) for end users and
developers who want to redistribute the Java Runtime
Environment (JRE). The JRE consists of the Java virtual
machine, the Java Core Classes, and supporting files.

JRE. See Java Runtime Environment.
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label. A discovered or user entered property value that
is displayed underneath each device in the Physical and
Data Path maps.

LAN. See local area network.
LBA. See logical block address.

local area network (LAN). A computer network
located on a user’s premises within a limited geographic
area.

logical block address (LBA). The address of a logical
block. Logical block addresses are typically used in
hosts’ /0 commands. The SCSI disk command
protocol, for example, uses logical block addresses.

logical unit number (LUN). An identifier used on a
small computer system interface (SCSI) bus to
distinguish among up to eight devices (logical units) with
the same SCSI ID.

loop address. The unique ID of a node in
fibre-channel loop topology sometimes referred to as a
loop ID.

loop group. A collection of storage area network
(SAN) devices that are interconnected serially in a
single loop circuit. Loop groups are discovered by the
SANavigator tool and displayed with a gray background
on the Physical and Data Path maps.

loop port. A node port (N_port) or fabric port (F_port)
that supports arbitrated loop functions associated with
an arbitrated loop topology.

LUN. See logical unit number.
MAC. See medium access control.

management information base (MIB). The
information that is on an agent. It is an abstraction of
configuration and status information.

man pages. In UNIX-based operating systems, online
documentation for operating system commands,
subroutines, system calls, file formats, special files,
stand-alone utilities, and miscellaneous facilities.
Invoked by the man command.

MCA. See micro channel architecture.

medium access control (MAC). In local area
networks (LANSs), the sublayer of the data link control
layer that supports medium-dependent functions and
uses the services of the physical layer to provide
services to the logical link control sublayer. The MAC
sublayer includes the method of determining when a
device has access to the transmission medium.

MIB. See management information base.

micro channel architecture (MCA). Hardware that is
used for PS/2 Model 50 computers and above to

provide better growth potential and performance
characteristics when compared with the original
personal computer design.

Microsoft Cluster Server (MSCS). MSCS, a feature
of Windows NT Server (Enterprise Edition), supports the
connection of two servers into a cluster for higher
availability and easier manageability. MSCS can
automatically detect and recover from server or
application failures. It can also be used to balance
server workload and provide for planned maintenance.

model. The model identification that is assigned to a
device by its manufacturer.

MSCS. See Microsoft Cluster Server.

network management station (NMS). In the Simple
Network Management Protocol (SNMP), a station that
runs management application programs that monitor
and control network elements.

NMI. See non-maskable interrupt.
NMS. See network management station.

non-maskable interrupt (NMI). A hardware interrupt
that another service request cannot overrule (mask). An
NMI bypasses and takes priority over interrupt requests
generated by software, the keyboard, and other such
devices and is issued to the microprocessor only in
disastrous circumstances, such as severe memory
errors or impending power failures.

node. A physical device that allows for the
transmission of data within a network.

node port (N_port). A fibre-channel defined hardware
entity that performs data communications over the
fibre-channel link. It is identifiable by a unique worldwide
name. It can act as an originator or a responder.

nonvolatile storage (NVS). A storage device whose
contents are not lost when power is cut off.

N_port. See node port.
NVS. See nonvolatile storage.

NVSRAM. Nonvolatile storage random access
memory. See nonvolatile storage.

Object Data Manager (ODM). An AIX proprietary
storage mechanism for ASCII stanza files that are
edited as part of configuring a drive into the kernel.

ODM. See Object Data Manager.

out-of-band. Transmission of management protocols
outside of the fibre-channel network, typically over
Ethernet.

PCI local bus. See peripheral component interconnect
local bus.
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PDF. See portable document format.

performance events. Events related to thresholds set
on storage area network (SAN) performance.

peripheral component interconnect local bus (PCI
local bus). A local bus for PCs, from Intel, that
provides a high-speed data path between the CPU and
up to 10 peripherals (video, disk, network, and so on).
The PCI bus coexists in the PC with the Industry
Standard Architecture (ISA) or Extended Industry
Standard Architecture (EISA) bus. ISA and EISA boards
plug into an IA or EISA slot, while high-speed PCI
controllers plug into a PCI slot. See also Industry
Standard Architecture, Extended Industry Standard
Architecture.

polling delay. The time in seconds between
successive discovery processes during which discovery
is inactive.

port. A part of the system unit or remote controller to
which cables for external devices (such as display
stations, terminals, printers, switches, or external
storage units) are attached. The port is an access point
for data entry or exit. A device can contain one or more
ports.

portable document format (PDF). A standard
specified by Adobe Systems, Incorporated, for the
electronic distribution of documents. PDF files are
compact; can be distributed globally by e-mail, the Web,
intranets, or CD-ROM; and can be viewed with the
Acrobat Reader, which is software from Adobe Systems
that can be downloaded at no cost from the Adobe
Systems home page.

premium feature key. A file that the storage
subsystem controller uses to enable an authorized
premium feature. The file contains the feature enable
identifier of the storage subsystem for which the
premium feature is authorized, and data about the
premium feature. See also feature enable identifier.

private loop. A freestanding arbitrated loop with no
fabric attachment. See also arbitrated loop.

program temporary fix (PTF). A temporary solution or
bypass of a problem diagnosed by IBM in a current
unaltered release of the program.

PTF. See program temporary fix.
RAID. See redundant array of independent disks.
RAM. See random-access memory.

random-access memory (RAM). A temporary storage
location in which the central processing unit (CPU)
stores and executes its processes. Contrast with DASD.

RDAC. See redundant disk array controller.

read-only memory (ROM). Memory in which stored
data cannot be changed by the user except under
special conditions.

recoverable virtual shared disk (RVSD). A virtual
shared disk on a server node configured to provide
continuous access to data and file systems in a cluster.

redundant array of independent disks (RAID). A
collection of disk drives that appears as a single volume
to the server and are fault tolerant through mirroring or
parity checking.

redundant disk array controller (RDAC). (1) In
hardware, a redundant set of controllers (either
active/passive or active/active). (2) In software, a layer
that manages the input/output (1/O) through the active
controller during normal operation and transparently
reroutes 1/Os to the other controller in the redundant set
if a controller or 1/0 path fails.

ROM. See read-only memory.

router. A computer that determines the path of
network traffic flow. The path selection is made from
several paths based on information obtained from
specific protocols, algorithms that attempt to identify the
shortest or best path, and other criteria such as metrics
or protocol-specific destination addresses.

RVSD. See recoverable virtual shared disk.
SAl. See Storage Array Identifier.

SA Identifier. See Storage Array Identifier.
SAN. See storage area network.

SATA. See serial ATA.

scope. Defines a group of controllers by their Internet
Protocol (IP) addresses. A scope must be created and
defined so that dynamic IP addresses can be assigned
to controllers on the network.

SCSI. See small computer system interface.

segmented loop port (SL_port). A port that allows
division of a fibre-channel private loop into multiple
segments. Each segment can pass frames around as
an independent loop and can connect through the fabric
to other segments of the same loop.

sense data. (1) Data sent with a negative response,
indicating the reason for the response. (2) Data
describing an I/O error. Sense data is presented to a
host system in response to a sense request command.

serial ATA. The standard for a high-speed alternative
to small computer system interface (SCSI) hard drives.
The SATA-1 standard is equivalent in performance to a
10 000 RPM SCSI drive.
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serial storage architecture (SSA). An interface
specification from IBM in which devices are arranged in
a ring topology. SSA, which is compatible with small
computer system interface (SCSI) devices, allows
full-duplex packet multiplexed serial data transfers at
rates of 20 Mbps in each direction.

server. A functional hardware and software unit that
delivers shared resources to workstation client units on
a computer network.

server/device events. Events that occur on the server
or a designated device that meet criteria that the user
sets.

SFP. See small form-factor pluggable.

Simple Network Management Protocol (SNMP). In
the Internet suite of protocols, a network management
protocol that is used to monitor routers and attached
networks. SNMP is an application layer protocol.
Information on devices managed is defined and stored
in the application’s Management Information Base
(MIB).

SL_port. See segmented loop port.

SMagent. The FASIT Storage Manager optional
Java-based host-agent software, which can be used on
Microsoft Windows, Novell NetWare, HP-UX, and
Solaris host systems to manage storage subsystems
through the host fibre-channel connection.

SMclient. The FAStT Storage Manager client software,
which is a Java-based graphical user interface (GUI)
that is used to configure, manage, and troubleshoot
storage servers and expansion units in a FAStT storage
subsystem. SMclient can be used on a host system or
on a storage management station.

SMruntime. A Java compiler for the SMclient.

SMutil. The FASIT Storage Manager utility software
that is used on Microsoft Windows, HP-UX, and Solaris
host systems to register and map new logical drives to
the operating system. In Microsoft Windows, it also
contains a utility to flush the cached data of the
operating system for a particular drive before creating a
FlashCopy.

small computer system interface (SCSI). A standard
hardware interface that enables a variety of peripheral
devices to communicate with one another.

small form-factor pluggable (SFP). An optical
transceiver that is used to convert signals between
optical fiber cables and switches. An SFP is smaller
than a gigabit interface converter (GBIC). See also
gigabit interface converter.

SNMP. See Simple Network Management Protocol and
SNMPv1.

SNMP time-out. The maximum amount of time the
SANavigator tool will wait for a device to respond to a
request. The specified time applies to one retry only.

SNMP trap event. (1) (2) An event notification sent by
the SNMP agent that identifies conditions, such as
thresholds, that exceed a predetermined value. See
also Simple Network Management Protocol.

SNMPv1. The original standard for SNMP is now
referred to as SNMPv1, as opposed to SNMPVv2, a
revision of SNMP. See also Simple Network
Management Protocol.

SRAM. See static random access memory.
SSA. See serial storage architecture.

static random access memory (SRAM). Random
access memory based on the logic circuit know as
flip-flop. It is called static because it retains a value as
long as power is supplied, unlike dynamic random
access memory (DRAM), which must be regularly
refreshed. It is however, still volatile, meaning that it can
lose its contents when the power is turned off.

storage area network (SAN). A dedicated storage
network tailored to a specific environment, combining
servers, storage products, networking products,
software, and services. See also fabric.

Storage Array ldentifier (SAl or SA Identifier). The
Storage Array Identifier is the identification value used
by the FASIT Storage Manager host software
(SMClient) to uniquely identify each managed storage
server. The FAStT Storage Manager SMClient program
maintains Storage Array Identifier records of
previously-discovered storage servers in the host
resident file, which allows it to retain discovery
information in a persistent fashion.

storage management station. A system that is used
to manage the storage subsystem. A storage
management station does not need to be attached to
the storage subsystem through the fibre-channel
input/output (I/O) path.

storage partition. Storage subsystem logical drives
that are visible to a host computer or are shared among
host computers that are part of a host group.

storage partition topology. In the FASIT Storage
Manager client, the Topology view of the Mappings
window displays the default host group, the defined host
group, the host computer, and host-port nodes. The
host port, host computer, and host group topological
elements must be defined to grant access to host
computers and host groups using logical drive-to-LUN
mappings.

subnet. An interconnected but independent segment
of a network that is identified by its Internet Protocol (IP)
address.

Glossary 67



sweep method. A method of sending Simple Network
Management Protocol (SNMP) requests for information
to all the devices on a subnet by sending the request to
every device in the network.

switch. A fibre-channel device that provides full
bandwidth per port and high-speed routing of data by
using link-level addressing.

switch group. A switch and the collection of devices
connected to it that are not in other groups. Switch
groups are discovered by the SANavigator tool and
displayed with a gray background on the Physical and
Data Path maps.

system name. Device name assigned by the vendor’s
third-party software.

TCP. See Transmission Control Protocol.

TCP/IP. See Transmission Control Protocol/Internet
Protocol.

terminate and stay resident program (TSR
program). A program that installs part of itself as an
extension of DOS when it is executed.

topology. The physical or logical arrangement of
devices on a network. The three fibre-channel
topologies are fabric, arbitrated loop, and point-to-point.

The default topology for the disk array is arbitrated loop.

TL_port. See translated loop port.

transceiver. A device that is used to transmit and
receive data. Transceiver is an abbreviation of
transmitter-receiver.

translated loop port (TL_port). A port that connects
to a private loop and allows connectivity between the
private loop devices and off loop devices (devices not
connected to that particular TL_port).

Transmission Control Protocol (TCP). A
communication protocol used in the Internet and in any

network that follows the Internet Engineering Task Force

(IETF) standards for internetwork protocol. TCP
provides a reliable host-to-host protocol between hosts
in packed-switched communication networks and in
interconnected systems of such networks. It uses the
Internet Protocol (IP) as the underlying protocol.

Transmission Control Protocol/Internet Protocol
(TCP/IP). A set of communication protocols that

provide peer-to-peer connectivity functions for both local

and wide-area networks.

trap. In the Simple Network Management Protocol
(SNMP), a message sent by a managed node (agent
function) to a management station to report an
exception condition.

trap recipient. Receiver of a forwarded Simple
Network Management Protocol (SNMP) trap.

Specifically, a trap receiver is defined by an Internet
Protocol (IP) address and port to which traps are sent.
Presumably, the actual recipient is a software
application running at the IP address and listening to
the port.

TSR program. See terminate and stay resident
program.

uninterruptible power supply. A source of power
from a battery that is installed between a computer
system and its power source. The uninterruptible power
supply keeps the system running if a commercial power
failure occurs, until an orderly shutdown of the system
can be performed.

user action events. Actions that the user takes, such
as changes in the storage area network (SAN), changed
settings, and so on.

vendor. Property value that the SANavigator tool uses
to launch third-party software. Vendor property might be
discovered, but will always remain editable.

worldwide name (WWN). A unique identifier for a
switch on local and global networks.

WORM. See write-once read-many.

write-once read many (WORM). Any type of storage
medium to which data can be written only a single time,
but can be read from any number of times. After the
data is recorded, it cannot be altered.

WWN. See worldwide name.

zoning. A function that allows segmentation of nodes
by address, name, or physical port and is provided by
fabric switches or hubs.
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shell, accessing 48
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copyback, logical drive 13
customize storage partioning information 30, 34

access controller shell 48
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single drive enclosure
final fibre channel connection 23
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storage expansion enclosures 19
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license requirement 1
used hard drives 15

AppWare 10 D
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cannot bring online 32 DACstore 43, 44

configuration data for drives incomplete 32 DCE 13

RAID-level modification 13 delete

redundancy checking 13 FlashCopy 34

return online 47 remote mirror relationships 34
attention 15, 16, 19, 26, 32, 33, 35, 38 _ storage partition mappings 34
automatically reset controllers 15, 16, 25, 27 disable drive migration settings 15, 24
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DisableDriveMigration.scr script 17
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logical drives 29, 35

storage server data 9, 46
bag or container, ESD 41
BootWare 10

drive displays as unconfigured 26
drive expansion enclosure weight 36
drive loop
optimal state 12
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C speed change procedure 2
drive loop pairs, maximum 4

cable drive loop state, determine 9
EXP500 to EXP700 3 drive loops Aand B 21, 37, 38
EXP700 to EXP500 3 drive migration
fibore channel connections 22, 23 prerequisites 9
new storage expansion enclosures 20 settings
trace fibre channel connections 35, 45 disable 15, 24

cannot bring array online 32 enable 26

catastrophic failure 13 re-enable 16, 25

change fibre channel speed settings 2 drives

check for configuration data 16 CRU asembly 31
on newly discovered drives 27 do not appear marked as Failed 32

Class A electronic emission notice 58 do not display 32

clear configuration data 25 maximum allowable 1

compliant state 44 remove

configuration configuration data 15
behavior after replacement 43 will not spinup 15, 19, 29
data, clear 25 DVE 13

configure drives 16 dynamic

container or bag, ESD 41 capacity expansion, DCE 13

controller volume expansion, DVE 13
blade, embedded unique identifier 43
drive loop LED 35, 45
firmware download during /0 12 E
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Electronic emission notices
Australia and New Zealand Class A statement 59
European Union EMC Directive conformance
statement 59
Federal Communications Commission (FCC)
statement 58
Industry Canada Class A emission compliance
statement 59
Japanese Voluntary Control Council for Interference
(VCCI) statement 60
Taiwanese Class A warning statement 60
United Kingdom telecommunications safety
requirement 59
electrostatic discharge (ESD) procedure 15
empty drive icon 32
emulation program, sample 48
EnableDriveMigration.scr script 16, 17, 27
enclosure ID 5
environmental service module (ESM) firmware 3
errors
drive enclosure lost redundancy path 21, 37, 38
loss of ESM path redundancy 35, 45
management event log (MEL) 9
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ESD bag or container 36, 41
ESM Fault LED 35, 45
ESM firmware
EXP500 11
EXP700 11
upgrade during I/0 10
version, current 11
version, upgrade 11
version, upgrade during I/O 12
event logs, interpreting 12
every unit items 44
execute script 15, 16, 24, 27
EXP500
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cabling 3
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ESM firmware 11
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ID switch location 20, 36
maximum per drive loop pairs 4
EXP700
1 Gbps fibre channel drives 19
and EXP500 in a redundant drive loop pair 2
cabling 3
drive loop pair maximum 4
ESM firmware 11
ID setting 6
ID switch location 20, 36
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expansion enclosure
ID setting 5
expansion enclosure speed setting 42, 46
expansion enclosures
cabling mixed 3
ESM firmware version 11
ID setting 20, 36, 47
LED state 47

expansion enclosures (continued)

migrate 33

speeds restriction 2
expansion unit enclosure speed setting 36
expansion units

ID setting 36

migrate 33

F

Failed icons 32
false storage server identification, example 47
FAStT documentation 51
FAStT Problem Determination Guide 45
FAStT Storage Manager
related documents 55
FAStT Storage Manager publications 8
FASLtT Storage Server
firmware 10
NVSRAM 10
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FAStT support
Web site 11
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enclosure IDs 20
HA Storage Server firmware and NVSRAM 10
Storage Server firmware and NVSRAM 10
FAStT500 RAID Controller Enclosure firmware and
NVSRAM 10
FAStT600
1 Gbps fibre channel drives 19
enclosure IDs 20
Storage Server firmware and NVSRAM 10
Turbo Storage Server firmware and NVSRAM 10
FAStT600 Fibre Channel Storage Server library 54
FAStT700 Storage Server firmware and NVSRAM 10
FAStT700 Storage Server library 53
FAStT900 Fibre Channel Storage Server library 51
FAStT900 Storage Server firmware and NVSRAM 10
FC Worldwide Name (WWN) 41, 43
FCC Class A notice 58
fibre channel
connections cabling 22, 23
drive firmware 12
insert drives 15, 16, 19, 25, 29, 32, 38
remove connection 21, 37
trace cable connections 35, 45
Worldwide Name (WWN) storage 41, 43
firmware
compatibility 10
controller 10
controller and NVSRAM levels 30, 33
controller, NVSRAM, and ESM levels 9
current 10
download 47
ESM, version by expansion enclosure 11
updates 11
verify controller and NVSRAM levels 45
firmware and NVSRAM
FAStT200
HA Storage Server 10

70  Adding and Migrating Drives and Expansion Enclosures to FAStT Storage Servers



firmware and NVSRAM (continued)
FAStT200 (continued)

Storage Server 10
FAStT500 RAID Controller Enclosure 10
FAStT600

Storage Server 10

Turbo Storage Server 10
FAStT700 Storage Server 10
FAStT900 Storage Server 10

FlashCopy
delete 30, 34, 45
recreate 32, 38, 48
flush /0 9, 46
flush server-cached I/O 9
force generation SA Identifier 48

G

GBIC 20, 35, 37, 45, 47

generate
new premium feature SAFE keys 41, 48
SA Ildentifier 48

gigabit interface converter 20, 35, 37, 45, 47

H

hard drives
add new 15
add storage expansion enclosures containing
add used 15
ID/Model Number 15, 19, 29
migrate 29
newly discovered 25
prerequisites 9
removal 31
will not spin up
help
center 12
online 13
prevent data loss 13
host group names, unique 30, 34
host kits, purchase 43
host names, unique 30, 34
host ports, unique 30, 34
HyperTerminal, Private Edition 48

15, 19, 29

I/0, flush 9, 46
IBM

Help Center, contact 12
IBMSAN.CDM multi-path software 12
icon

empty drive 32

Failed 32, 38, 47

Subsystem Management window 32, 38, 47
ID

conflict LED 35, 45

switch location 20

ID/model number, hard drive 15, 19, 29

19

identify
1 Gbps FC drives 15, 19, 29
firmware updates 11
ignore
configuration data setting 15
configuration information 24
impact of new storage server
on identification 43
on premium features 43
IN port 21, 37, 38
initialize a drive 38
insert fibre channel drives 25, 32, 38
intermixed enclosure ID settings 7
IP addresses 44

L

LED
controller drive loop 35, 45
expansion enclosure states 47
ID conflict 35, 45
port bypass 35, 45
license requirements 1
Linux failover adapter driver
multi-path software 12
listing
DisableDriveMigration.scr script file 17
EnableDriveMigration.scr script file 17
load script 15, 16, 27
logical drive
backup 29, 35
copyback 13
creation, FlashCopy 13
creation, VolumeCopy 13
dynamic capacity expansion 13
flashcopies, delete 30
reconstruction 13
segment size modification 13
sparing 13
synchronization, remote mirror 13
verify name 30
Loop Initialization Primitive (LIP) 35
loss of ESM path redundancy error 35, 45

M

machine type 1722
Model 60U 1, 10
Model 60X 1, 10
Model 6LU 1, 10
Model 6LX 1, 10

machine type 1742
Model 1RU 1, 10
Model 1RX 1, 10
Model 90U 1, 10
Model 90X 1, 10

machine type 1750
Model 1RU 11
Model 1RX 11

machine type 3542
Model 1RU 1, 10
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machine type 3542 (continued) model number (continued)

Model 1RX 1, 10 FAStT700
Model 2RU 1, 10 1RU 1,10
Model 2RX 1, 10 1RX 1,10
machine type 3552 FAStT900
Model 1RU 1, 10 90U 1,10
Model 1RX 1, 10 90X 1,10
machine type 3560 move fibre channel drives 12
Model 1RU 11 multi-path software
Model 1RX 11 IBMSAN.CDM 12
management event log errors 9 Linux failover adapter driver 12
map drives 16 RDAC 12
maximum
allowable drives 1
drive expansion enclosures 4 N
drives per redundant drive loop pair 4 Needs Attention
storage expansion enclosures 4 condition 43
MEL errors 9 state 12
menu option new storage server impact 43
Advanced ~» Reset Controller 16, 27 notes, important 58
Array » Check Redundancy 13 notices
Execute 25, 27 electronic emission 58
Script 16, 27 FCC, Class A 58
File » Load Script 15, 16, 24, 27 null modem serial cable 48
Initialize 32 NVSRAM
Place » Offline 30, 35, 46 clear codes 44
Place » Online 32, 38 codes pre-loaded 44
Tools » Verify and Execute 15, 16, 25, 27 FASIT Storage Server 10
migrate fibre channel drives 12 stores IP addresses 44
migrate hard drives 29 verify level 9, 11, 33, 45
migrate storage expansion enclosures with drives 33 version, by controller firmware version 10
minihub speed, set 46 NVSRAM and controller firmware
mix expansion enclosures 2 FAStT200
mixed configuration HA Storage Server 10
EXP500 to EXP700 cabling 3 Storage Server 10
EXP700 to EXP500 cabling 3 FAStT500 RAID Controller Enclosure 10
model number FAStT600
FAStT EXP500 Storage Server 10
1RU 11 Turbo Storage Server 10
1RX 11 FAStT700 Storage Server 10
FAStT EXP700 FAStT900 Storage Server 10
1RU M1
1RX 11
FAStT200 (0]
1RU 1,10 offline state 32, 35, 38, 46
1RX 1,10 online help 13
2RU 1,10 online state 32, 38, 47
2RX 1,10 optimal state 9, 12, 19, 29, 30, 32, 33, 34, 35, 45, 47
FAStT500 OUT port 21, 37, 38
1RU 1,10 out-of-band storage server IP addresses 47
1RX 1,10 out-of-compliance state 41, 43
FAStT600
60U 1,10
60X 1,10 P
FA?:_TSOﬂ ,S;’:)g'e Controller port bypass LED 21, 35, 37, 38, 45

post-replacement configuration behavior 43

6LX 1,10 X : .
FAS{T600 Turbo post-upgrade configuration behavior 43

60U 1, 10 p°"c‘;e,r on , | )

60X 1,10 rive expansion enclosure

storage expansion enclosure 2
storage server 2
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premium feature
enable status 43, 44
generate new SAFE keys 41, 48
IBM assigns entitlements 43
identifier 43
impact of new storage server on 43
re-enable 43

prerequisites
adding capacity 9
drive migration 9

prevent
data loss 13, 16, 26
shock 31, 36
procedure

access controller shell 48
add new hard drives 15
add storage expansion enclosures 19
disable drive migration settings 15
electrostatic discharge (ESD) 15
enable drive migration settings 16
flush server-cached I/O 9
migrate hard drives 29
migrate storage expansion enclosures with
drives 33
redeploy original (replaced) storage server 48
save a module profile report 13
save a storage subsystem profile 13
unmount file systems 9
upgrade
storage server 41, 45
profile
FASLtT Storage Server 13
proofs of purchase 41, 44, 46
publications, FAStT Storage Manager 8
purchase
entittements 1, 41, 43
host kits 41, 43

Q

Quorum disk 46

R

RAID-level modification 13
re-enable
drive migration settings 16
premium features 41, 43
Read_Link_Status
function 9, 12
readme file 12, 19, 33, 41
reconstruction, logical drive 13
Recovery Guru 9
redeploy original (replaced) storage server 48
redundancy checking 13
redundant disk array controller [RDAC]
multi-path software 12
redundant drive loop pair 1, 4
remote mirror
logical drive synchronization 13

remote mirror (continued)
relationships
delete 34, 45
recreate 38, 48
remove 30
remove
configuration data 15
drive expansion enclosure 35
drives 29, 36
fibre channel connection 21, 37
hard drives 31
out-of-compliance errors 48
remote mirror relationships 30, 34
storage components 15, 19, 29, 33
storage expansion enclosure 35
storage server 45, 46
reset
controllers 16, 24, 48
automatically 25
controllers automatically 27
storage subsystem setting 15, 16
restore a storage subsystem configuration 13

S

SA Identifier 43
force generation 48

SAFE
ID 43
key 46

Premium Feature Identifier 43
safety information iii
SAl 43
Saving a module profile report and state capture
information to help prevent data loss 13
schedule upgrades 12, 19, 33, 46
script
DisableDriveMigration.scr 17
editor window 16, 24, 27
EnableDriveMigration.scr 17
execute 15, 16, 24, 27
load 15, 16, 24, 27
set drive expansion enclosure ID 36
set minihub speed 46
set storage expansion enclosure ID 36
setting
out-of-band storage server IP addresses 47
settings
disable drive migration
become effective 16
drive migration
disable 15, 24
enable 26
re-enable 16, 25
expansion enclosure speed 46
fibre channel speed 2
SFP 20, 35, 37, 45, 47
shutdown
drive expansion enclosure 2
storage expansion enclosure 2
storage server 2
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small form-factor pluggable 20, 35, 37, 45, 47
SMclient 43
software compatibility
Web site 12
sparing, logical drive 13
speed restriction
drive expansion enclosure 2
storage expansion enclosure 2
speed settings
drive loop 2
expansion enclosure 46
state
compliant 44
expansion enclosure LED 47
Needs Attention 12
offline 29, 32, 35, 38, 46
online 32, 38, 47
optimal 9, 12, 15, 19, 29, 30, 32, 33, 34, 35, 45, 47
out-of-compliance 41, 43
static IP address
storage 44
storage
components removal 33
FASIT Storage Server profile 9, 13
Fibre Channel Worldwide Name (WWN) 43
static IP address 44
Storage Array Identifier 43
storage expansion enclosure weight 36
Storage Manager
installation and support guide 11, 13, 19, 33, 41, 47
installation CD 15, 16, 24, 27
storage partition mappings
delete 34
storage partitioning definitions, view 32, 39
storage pool, unconfigured capacity 38
storage server
configuration behavior after
redeployment 43
upgrade and replacement 43
configuration migration 13
controller firmware behavior after upgrade 42
controller firmware version 10
false identification example 47
identification 43
physical configuration, alter 15, 19, 29, 33
redeploy 48
status 12
upgrade NVSRAM version 10
storage subsystem
optimal state 12
restore configuration 13
storage subsystem profile
restore 13
save 9,13
storage 9, 13
Subsystem Management window icon 32
suspend I/O from hosts during drive firmware
upgrade 12
switches
ID 20

synchronization
remote mirror logical drive 13

—~

tasks by documentation title 51

technical background on storage server controller
firmware behavior 42

terminal emulation program, sample 48

trace fibre channel cable connections 35, 45

U

unconfigured capacity storage pool 38
United States electronic emission Class A notice 58
United States FCC Class A notice 58
unmount file systems 9, 29, 35, 46
upgrade
drive firmware 12
ESM firmware 11
schedule 10, 12, 19, 33, 46
storage server 45
important considerations 41
in functioning configuration 41, 45
used hard drives 15
user tasks
FAStT600 Fibre Channel Storage Server 54
FAStT700 Fibre Channel Storage Server 53
FAStT900 Fibre Channel Storage Server 51
related documents 55

w

Web site 13
FAStT documentation 8
FAStT support 11
software compatibility 12
support 13
weight of drive expansion enclosure 36
window
Client Subsystem Management 13, 21, 35, 37, 38,
45
Enterprise Management 15, 16, 24, 26
Load Script file selection 15, 16, 24, 27
Read_Link_Status 12
Reset Controller 16, 25, 27
script editor 15, 16, 24, 27
Storage Subsystem Management 13, 16, 25, 27,
29, 32, 35, 38, 46, 47
WWN 41, 43
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Readers’ comments — we would like to hear from you.
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